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About the Manuals

About the Manuals
The TENORI-ON is provided with the four manuals listed below.

(7] Quick Guide

The Quick Guide provides instructions on setup and basic operation that will get you started
as quickly as possible.

TENORI-ON Manual (This manual; PDF)

The manual is provided as an electronic document on the supplied CD-ROM, and it provides
detailed descriptions and procedures that will help you take full advantage of the TENORI-
ON's many advanced features. Refer to the Quick Guide for basic information such as
turning on the power, the functions of the panel controls, and more.

m Precautions

This document lists a number of points you need to be aware of in order to use the TENORI-
ON properly and safely. Please read it carefully. Guarantee information and after-service
contact details are also included.

m Installation Guide

Explains the procedure for installing the "TENORI-ON User Voice Manager" software that is
included on the supplied CD-ROM on your computer.

Using the PDF Manual

o Click the item you want to refer to in the "Bookmarks" index to the left of the main display
window to go to the corresponding page. Click the "Bookmarks" tab to open the index if it
is not showing.

o Click the page numbers that appear in the table of contents to go directly to the
corresponding page.

o Select "Find" or "Search" from the Adobe Reader "Edit" menu and enter a key word to
locate related information anywhere in the document. Click an item in the list that appears
after searching to go directly to the corresponding page.

NOTE The names and positions of menu items may vary according to the version of Adobe Reader being used.

The illustrations and LCD screens as shown in this owner’s manual are for instructional purposes only, and may appear
somewhat different from those on your instrument. The illustrations and LCD screens from the TNR-W are used for the
instructions and descriptions in this manual.

Copying of the commercially available musical data including but not limited to MIDI data and/or audio data is strictly prohibited
except for your personal use.

When using a power adaptor, even when the STANDBY/ON switch is in the "STANDBY" position, electricity is still flowing to the
instrument at the minimum level. When you are not using the instrument for a long time, make sure you unplug the AC power
adaptor from the wall AC outlet.

Please note that there may be slight variations in the color of the LED buttons.
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The TENORI-ON Is ...

Layers and Performance Modes

The TENORI-ON Is ...

The TENORI-ON is a new type of musical interface that combines control and display
functions in matrix of 256 LED buttons.

The 16 x 16 TENORI-ON matrix can be operated easily and intuitively, so that anyone can
begin playing the instrument right away. Light animation is generated in synchronization with
the performance and sound.

Layers and Performance Modes

The TENORI-ON has 16 layers divided into 6 different "modes" with different input methods
and types of sound/light response.

Each layer individually memorizes note timing, voice, pitch, loop position and other
parameters. The performance modes and the layers they are associated with are listed in
the table below. Up to 16 layers can be played simultaneously, allowing a vast range of
possibilities for rich, complex musical expression and performance.

[Reference]
# SwitchingLayers . ............ ... .. ... Layer Number — Page 30
Layer No. Mode Operation Page
1—7 Score The vertical axis corresponds to pitch while the horizontal axis is looped time. 15
8—11 Random Notes loop and flash in the order in which they were entered. 17
12—13 Draw LED button operation is memorized over a certain time frame and repeated. 18
14 Bounce A "bouncing ball" visual effect with repeated notes. 19
15 Push Press LED buttons for a certain time to produce sustained notes. 20
16 Solo Notes are repeated while the LED buttons are held. 21

The 16-layer Concept

Performance data entered on the LED button matrix.

Layer Number 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
L |

Mode Score Mode Random Mode Draw Mode Bounce Push Solo

Mode Mode Mode
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The TENORI-ON Is ...

Layers and Blocks

Layers and Blocks

The TENORI-ON handles a complete set of 16 layers as a "block." You can have up to 16
blocks, each with up to 16 layers. You can switch between blocks instantaneously to create
varied performances with plenty of musical interest.

Parameters that apply to individual layers (voice, pitch, note entry position, etc.) are
internally managed separately from parameters that apply to individual blocks (master
tempo, master transpose, master scale, etc.). This makes it possible, for example, to create
variations within the same song in which only the note timing is altered, and instantly switch
between variations. The only exception is that layers have the same voices throughout all
bocks (e.g. layer 3 in block 1 will use the same voice as layer 3 in block 10), so changing
blocks won't change the voice for a given layer.

The Layer/Block Relationship

¢ Block Switching
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Since the blocks will usually hold similar performance data, convenient block copy functions
are provided.

[Reference]

s Block = Block Copy . ... ..o Block Number — Page 34
Copy this Block — Page 55

# Layer » Layer Copy .. ... Block Number — Page 34
Copy this Layer = Page 56

# Block Switching . .. .......... ... o Block Number — Page 34
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The TENORI-ON Is ...

Voices

Voices

The various sounds that can be played by the TENORI-ON are called "voices." The TENORI-
ON can use up to 256 voices, 253 of which are built in and play via the internal MIDI tone
generator. A wide range of voices including piano, strings, drums, percussion, sound
effects, and voices developed specifically for use with the TENORI-ON are provided.

The remaining three voice numbers are reserved for voice samples provided by the user.
Samples you have created using your computer or downloaded can be converted and
assigned for use with the TENORI-ON by using the supplied TENORI-ON User Voice
Manager software, saved to an SD Memory Card, and then loaded into the TENORI-ON.
User voice can be played in the same way as the internal MIDI tone generator voices.

A different voice can be assigned to each layer, and all notes played on a given layer will be
played using the same voice. Multiple layers with different voices assigned to each can be
played simultaneously. But of course you could also assign the same voice to multiple
layers. Maximum polyphony (the maximum number of notes that can be played
simultaneously) is 32. If more than 32 notes are played at the same time, only the last
(newest) 32 notes will be played.

The voices can be varied by adjusting gate time (the length of the notes), transposition,
octave shift, and other parameters. There’s also a Master Tuning parameter that can be used
to tune the MIDI tone generator voices.

The ionian C scale is assigned to layer pitches by default (i.e. the LED buttons produces
pitches corresponding to the white keys on a piano). The default scale can be changed via
the menu.

MIDI drum voices have no pitch variation. Each LED button produces the sound of a different
drum or percussion instrument. For this reason scale, octave shift, and transpose settings
have no effect on drum voices.

Reverb and chorus effects can be applied to the voices. The effect type and depth can be
set as required.

A number of other variations can be applied to voices. Refer to the items listed below for
more information.

[Reference]

# ChangingVoices . ........................ Instrument — Page 24, 49

# Adjusting Volume. . .......... ... Hardware Volume — Page 43
Volume — Page 33, 50

=+ Changing Note Length (Gate Time) .......... Sound Length = Page 25, 52

# Octave Shift. . ... . ... .. Octave = Page 26

s Transposition. . ... oo Master Transpose — Page 32, 45

o TUNING L Master Tuning — Page 60

# ChangingScales......................... Master Scale - Page 44
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The TENORI-ON Is ...

Connecting to Second TENORI-ON or Computer

=+ Panning (Stereo Positioning) . . .............. Panpot - Page 53
+ Effects (Reverb and Chorus). . .............. Effect Menu — Page 99
# Loading Samples. . ... ... o Samplings — Page 88

The supplied "TENORI-ON User Voice manager" software
installation guide.

Connecting to Second TENORI-ON or Computer

The TENORI-ON has a mini-DIN type MIDI connector that, via the supplied MIDI cable
adaptor, can be connected to a second TENORI-ON to allow synchronized performance, or
to a computer to allow recording of the instrument’s MIDI output.

[Reference]

s MIDI Specifications .. ..................... MIDI Data Format — Page 115
MIDI Implementation Chart — Page 118

Transmitting the TENORI-ON MIDI Output to a Computer

TENORI-ON performance data (MIDI data) can be transmitted to a computer where it can be
recorded and processed.

@ Connecting to a Computer

TENORI-ON

—
MIDI IN
MIDI OUT
_| 2l v UsB et j i
=
Supplied MIDI Cable Interface i
Adaptor MIDIIN - \vipr ouT Computerg

e Synchronized Performance with Other TENORI-ON Instruments

Two TENORI-ON instruments can be connected via MIDI so that when playback is started or
paused on the "Master" TENORI-ON, the "Slave" TENORI-ON follows. To use this capability
one of the connected TENORI-ON instruments must be set to Master status and the other
must be set to Slave. It is also possible to synchronize more than two TENORI-ON
instruments in this way. In such cases only one TENORI-ON can function as the Master while
all others are Slaves.

[Reference]

=+ Master/Slave Settings for Synchronized PerformanceSynchronize — Page 61

TENORI-ON Manual 7



The TENORI-ON Is ...

Connecting to Second TENORI-ON or Computer

Connecting Two TENORI-ON Instruments

Sunchronize =] Sunchronize =]
M&STER
MASTER TENORI-ON
B v
Supplied MIDI Cable MIDI OUT MIDI Cable mipiout | Supplied MIDI
Adaptor _:-)\ ::'_ Cable Adaptor
>
MIDI'IN MIDI IN
Connecting More than Two TENORI-ON Instruments
Sunchronize =] Sanchronize =
M&STER
MASTER TENORI-ON SLAVE TENORI-ON
o [ R | | R
o o
> 0 T oo oo
I MIDI I MIDI I MIDI
MIDI MIDI OUT
MIDIIN  MIDIOUT  Caple
Supplied MIDI OUT Smm—m- Supplied Supplied
MIDI Cable > m—a-- MIDI IN MIDI Cable MIDI Cable
Adaptor MIDI MIDI Interface T~ Adaptor Adaptor
Cable MIDI
MIDI IN Cable -_I
Sm—m>m—]
MIDI'IN

MIDI OUT

Power-on Procedure

If you have the TENORI-ON connected to an external sound system, it is important to turn
the devices in your audio chain on in the correct order to prevent unwanted noise as well as
possible damage to your equipment.

Before turning the power on, make sure that any volume controls on all devices are turned all
the way down.

When turning power on, you should normally begin with the source and end with power
amplifiers or powered speakers. Here’s an example:

1. TENORI-ON = 2. Mixer =& 3. Powered Speakers
The opposite applies when turning power off:

1. Powered Speakers =9 2. Mixer = 3. TENORI-ON
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The TENORI-ON Is ...

Song Recording and Playback

Song Recording and Playback

Performance operations carried out on the TENORI-ON can be recorded in real time and
saved to an SD Memory Card as a Song File.

Song Files contain all performance operations (note entry, etc.), settings (voice selection,
tempo, etc.) and other user operations carried out in all layers and blocks in real time. A
recorded Song File can then be loaded in into the TENORI-ON and played back, precisely
reproducing LED button and function button operations precisely as they were recorded.
Song files can be transferred to a computer and made available on the Internet or attached
to email messages to other TENORI-ON users.

[Reference]
< Recording TENORI-ON Performances . ....... Recording Menu — Page 109
+ Song File Operations. . .................... File Menu/Song — Page 64
< Using the Supplied Software. . . ............. The supplied "TENORI-ON User Voice manager" software

installation guide.

SD Memory Card File Types and Operations

In addition to Song Files, the following file types can be saved to and loaded from SD
memory cards, as well as renamed or deleted as required.

File Type Content
All Blocks Performance data and settings for all layers and blocks.
Current Block Performance data and settings for all layers in the current block.
Current Layer Performance data and settings for the current layer in the current block.
All Settings All data other than the note entry points for all layers and blocks.

Samples you have created on a computer or downloaded from the Internet can be
converted to TENORI-ON file format using the supplied TENORI-ON User Voice Manager

Samplings and loaded into the instrument’s user voice memories (voice numbers <01/16,> <02/16,>
and <03/16>) for playback. User voices can be saved to and loaded from SD Memory
Cards.
[Reference]
< File Operations. . ......................... File Menu — Page 62
+ Sample Save/load. ....................... Samplings — Page 88

The supplied "TENORI-ON User Voice manager" software
installation guide.
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The TENORI-ON Is ...

Non-performance Functions (Interior and Power Save Modes)

Non-performance Functions (Interior and Power Save Modes)

When set to the Interior Mode the TENORI-ON will function as a clock and/or play back
songs automatically. There’s also a Power Save Mode that automatically puts the TENORI-
ON to "sleep" if it isn’t operated for a specified period of time.

Interior Mode

You can set up the TENORI-ON to function as a clock and play back songs automatically.

It can play a composition you have created as an alarm or time hourly reminder. Alternatively,
it can be set to play a song you have created or the demo song while the time is being
displayed.

Power Save Mode

This energy-saving feature stops the sequencer and turns all LED buttons off.

e Interior Mode Operation (Interior Types)

Song (DEMO) Plays the pre-programmed TENORI-ON demo song.
SONG (SD) Randomly plays Song Files from an SD Memory Card.
Clock Displays the time on the TENORI-ON matrix.

Displays the time on the TENORI-ON matrix while playing the pre-programmed TENORI-ON

lock ng (DEM
Clock + Song ( ©) demo song. The demo song light animation appears on the matrix in addition to the time.

Displays the time on the TENORI-ON matrix while randomly playing Song Files from an SD

Clock + Song (SD) Memory Card. The song light animation appears on the matrix in addition to the time.

o Clock Functions

e The hour and minute are displayed numerically on the LED button matrix in 24-hour
format. Seconds are indicated by a dot that moves around the outermost 60 LED buttons,
and an "expanding-square" light animation that occurs once per second.

e The hour reminder sound can be turned ON or OFF.
e The alarm can be turned ON or OFF.
e The alarm time can be set as required.

e Original hourly reminder and alarm sounds can be created.

[Reference]

# Interior Mode Settings . . ... Interior Menu — Page 1071
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The TENORI-ON Is ...

Non-performance Functions (Interior and Power Save Modes)

Example: 15:39:18 (three thirty-nine PM and eighteen seconds)

Interior Type

Second Indicator
B “(Clock+Sons(DEMOY (=
Animation ‘ “DEMO b
Yamaha
13:39:18
|

Minute Time Display

Owner name
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The TENORI-ON Is ...

Performance Modes Basic Operation

Performance Modes

This section describes the 6 TENORI-ON performance modes that are assigned to the 16
layers. A thorough understanding of the modes will help you to create more interesting,
unique performances.

Basic Operation

The basic settings and operations used for TENORI-ON performance are described below.

e The Display

When the TENORI-ON is turned on layer 1 and the Score mode will be selected. You can
begin creating compositions right away by simply entering notes via the LED buttons. When
the power is initially turned on the start-up screen will appear for a few seconds, and then
the status display will appear. The status display will be shown during TENORI-ON
performance. To return to the Status display, press the [CANCEL] button as many times as
necessary.

Status Display

Vs

TENORI-OM &=
¢ | EIDGI-coore  ENDYI
0 | [EE#H1 /81 Photon

o | MLBTH e S

(6]
QO LAYER[MEER] . ..................... ... The current layer number and mode.
O BLOCK [MEER] .. ... The current block number.
O POWER[@E]. ... Current power status.

(] AC adaptor in use.

[@=] Battery full (battery power).

[@] Battery half full (battery power).

[ca] Battery almost depleted (battery power).
(=] Battery depleted (battery power).

* The TNR-O model has no remaining battery indicator, only a power adaptor display.

O INSTIEER]. . ... Current voice number and name.
© TIVE [mm] / REC (=] / PLAY [ER] . ... ... Displays the time during normal performance: [HmE h:m:s].

Displays elapsed time during recording: == h:m:s].
Displays elapsed time during playing: [EXE» h:m:s]

@ STOP [wpzm] /START (pEZE] . ... ... ....... [wezmm] during normal performance and recording.
[»EEE ] When playback is stopped.

A When the power status indicator shows that the batteries are almost depleted ([T1]), replace all six
batteries with new ones as soon as possible.
If the remaining battery power drops even lower [&] will be displayed and SD Memory Card access will
not be possible. Change the batteries immediately. (TNR-W only)

TENORI-ON Manual 12



The TENORI-ON Is ...

Performance Modes Basic Operation

Basic Settings and Editing During Performance

e [CLEAR] button

Press the [CLEAR] button to clear all active notes from the layer.

Clear All Active Notes from the Layer

Press the [CLEAR] button briefly.

Clear All Active Notes from All Layers and
Blocks

Press and hold the [CLEAR] button.

o Function Button Settings/Edits

Basic settings and edits are made during performance using the [L1] — [L5] functions

buttons, [R1] — [R5] functions buttons, and LED buttons.

[Reference]

¢ Using the Function Buttons . . . . . ..

.......... TENORI-ON Quick Guide,
Setting Parameters with the Function Buttons — Page 23

Changing Voices

Use the LED buttons while holding the [L1] button (= Page 24).

Change Note Length

Use the LED buttons while holding the [L2] button (— Page 25).

Change the Octave

Use the LED buttons while holding the [L3] button (= Page 26).

Change the Score Mode Loop Range

Use the LED buttons while holding the [L4] button (— Page 27).

Rotate Shape in the Random Mode

Use the LED buttons while holding the [L4] button (— Page 28).

Adjust Loop Speed

Use the LED buttons while holding the [L5] button (= Page 29).

Change Layers

Use the LED buttons while holding the [R1] button (— Page 30).

Change the Tempo

Use the LED buttons while holding the [R2] button (— Page 31).

Transposition

Use the LED buttons while holding the [R3] button (— Page 32).

Adjust the Layer Volume

Use the LED buttons while holding the [R4] button (— Page 33).

Change Blocks, Copy Layer, Copy Block

Use the LED buttons while holding the [R5] button (— Page 34).
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The TENORI-ON Is ...

¢ Menu Settings/Edits

Performance Modes Basic Operation

Detailed TENORI-ON settings can be accessed and edited by using the jog dial to select
menu items on the LCD display. File save and load operations can also be accessed this

way.

[Reference]

# UsingtheMenus ................

......... Setting Parameters with the Jog Dial = Page 36

Stop Playback

Press the [OK] button at the point you want to stop playback while the Status
Display is shown. Press the [OK] button a second time and playback will
resume from that point.

Adjust Overall Volume

Use the jog dial and [OK] button to go to the "Hardware Volume" display (—
Page 43).

Mute Output

Use the jog dial and [OK] button to go to the "Mute" display (— Page 47).

Adjust Layer Panning

Use the jog dial and [OK] button to go to the "Panpot" display (— Page 53).

Apply a Reverb or Chorus Effect

Use the jog dial and [OK] button to go to the "Effect menu" display (—
Page 99).

Change the Light Animation

Use the jog dial and [OK] button to go to the "Animation” display (— Page 53).

Clear All Active Notes from the Layer

Press the [CLEAR] button briefly. Alternatively, use the jog dial and [OK] button
to go to the "Clear this layer" display (— Page 57).

Clear All Active Notes from All Layers and
Blocks

Press and hold the [CLEAR] button. Alternatively, use the jog dial and [OK]
button to go to the "Clear All Blocks" display (— Page 57).

Reset All Layers and Blocks

Use the jog dial and [OK] button to go to the "Reset All Blocks" display (—
Page 58).

Copy Active Notes

Use the jog dial and [OK] button to go to the "Copy this block" display (—
Page 55) or "Copy this layer" display (= Page 56).

Change Scales

Use the jog dial and [OK] button to go to the "Master Scale" display (—
Page 44).

Adjust MIDI Tone Generator Tuning

Use the jog dial and [OK] button to go to the "Master Tuning" display (—*
Page 60).

Reset the Playback Loop

Use the jog dial and [OK] button to go to the "Reset Loop Timing" display (—
Page 46).

Determines whether notes played on the
TENORI-ON will sound via the internal tone
generator or not

Use the jog dial and [OK] button to go to the "Local Control" display (—
Page 61).

Adjust the LED Button Long-press Time

Use the jog dial and [OK] button to go to the "Push Sensitivity" display (—
Page 60).

File Operations

Use the jog dial and [OK] button to go to the "File menu" display (— Page 62).

Format an SD Memory Card

Use the jog dial and [OK] button to go to the "SD Format" display (—
Page 107).

Factory Reset

Use the jog dial and [OK] button to go to the "Factory Reset" display (—
Page 108).

Record a performance

Use the jog dial and [OK] button to go to the "Recording Menu" display
(—Page 109).

More detailed menu settings than listed in the above chart are described in the
following pages. Understand all the possibilities offered by the TENORI-ON can help
you gain maximum enjoyment from the instrument.
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The TENORI-ON Is ...

Performance Modes Score Mode

Score Mode

The Score Mode is assigned to TENORI-ON layers 1 — 7.
The Score Mode is selected by default when the power is turned on.

Score Mode Operation

In this mode the TENORI-ON interface functions like a musical "score" on which you can
write the notes to be played in one musical measure via the 16 x 16 LED button matrix.
The "loop indicator" (four lit LED buttons in a vertical column) proceeds from left to right, and
active notes will play when the loop indicator passes over them. Light animation will also
occur for each note played. The loop indicator will loop back to the beginning once the right
edge of the matrix is reached.
Press the [OK] button while the highlighted "STOP" indicator in the lower right corner of the
LCD display is shown to temporarily pause loop playback. The loop indicator will stop at the
position at which the [OK] button is pressed. Press the [OK] button a second time and loop
playback will resume from the point at which it was paused. You can change the point from
which playback will resume by moving the paused loop indicator to the desired position
(press an LED button at the desired start position).

[Reference]

=+ Setting the loop beginning and end points. (Master Loop Point = Page 46, Loop Point — Page 27)

= Changing the loop indicator speed (beat speed). (Loop Speed — Page 29, 51)

# Turning the loop indicator off. (Loop Indicator — Page 61)

= Changing the light animation. (Animation - Page 53)

The horizontal axis corresponds to time and the vertical axis corresponds to the pitch of the
notes played. The factory default scale for the vertical axis is an ionian scale, corresponding
to the white keys on a piano.

[Reference]

=+ Selecting a scale other than the ionian scale. (Master Scale —»Page 44)

=+ Changing octaves. (Octave — Page 26)

If a drum voice is selected each note on the vertical axis does not correspond to a different
pitch in the scale, but rather to a different instrument in the drum "kit." See "Voices" on
Page 6.

Press an LED button briefly to play the sound assigned to it. If you hold the LED button a bit
longer it will remain lit and will become an active note. Press and hold an active note to de-
activate it (the LED button will go out).

[Reference]

+ The press-and-hold time for note entry can be changes as required. (Push Sensitivity = Page 60)

« The note length (gate time) can be changed as required. (Sound Length — Page 25, 52)
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The TENORI-ON Is ...

Performance Modes Score Mode

Loop Indicator Active Notes Loop Indicator Motion Sound/Light

Pitch

Light Animation
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The TENORI-ON Is ...

Performance Modes Random Mode

Random Mode

The Random Mode is assigned to layers 8 — 11.

Random Mode Operation

If you press an LED button long enough to enter an active note in the Random Mode, the
active note will play back repeatedly. If you then enter a few more active notes, the lights will
"travel" from note to note, in the order entered, and the active notes will sound when the
traveling light passes over them. The Random Mode thus produces a totally different type of
loop from the Score Mode.

[Reference]

# The next active note will play at the specified 1-beat timing. The length of each beat can be adjusted via the
Loop Speed parameter (Loop Speed — Page 29, 51. Master Loop Speed — Page 45).

You can even spin loop-shapes you create in the Random Mode by holding the [L4] button
and running a finger around the matrix in the direction and at the speed of the desired spin.
The pitches of the notes will change accordingly as the shape spins, producing loop sound
effects.

[Reference]

+ Rotation - Page 28

Press an LED button briefly to play the sound assigned to it. If you hold the LED button a bit
longer it will remain lit and will become an active note. Press and hold an active note to de-
activate it (the LED button will go out).

[Reference]

= The press-and-hold time for note entry can be changes as required. (Push Sensitivity - Page 60)

+ The note length (gate time) can be changed as required. (Sound Length — Page 25, 52)

As in the Score Mode the factory default scale for the vertical axis is an ionian scale,
corresponding to the white keys on a piano. Nothing is assigned to the horizontal axis, but
the timing between notes will depend on the distance between the notes on the matrix.

[Reference]

= Selecting a scale other than the ionian scale. (Master Scale — Page 44)

-+ Changing octaves. Octave — Page 26)

=+ Changing the light animation. (Animation - Page 53)

Note entered in order from 1 — 3 will play in the same )
sequence. When a shape is rotated the notes

will play/light during rotation.
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The TENORI-ON Is ...

Performance Modes Draw Mode

Draw Mode

The Draw Mode is assigned to layers 12 and 13.

Draw Mode Operation

In this mode you can press individual LED buttons or draw lines or curves on the matrix, and
those actions will be played back and repeated. You can keep adding to your "composition"
during playback to build up thick sonic textures.

[Reference]

=+ Recording and playback of LED button operations loops in 16th-beat increments in the Score mode. LED
button operations are played back in the next loop. The loop length (cycle) can be adjusted via the Loop
Speed parameter (Loop Speed — Page 29, 51. Master Loop Speed — Page 45).

+ In the Draw Mode you cannot clear only a part of the performance. The entire layer can be cleared by
pressing the [CLEAR] button.

When a button is pressed it will sound and be activated immediately. In the Draw Mode there
is no need to press and hold a button to enter a note. Because this, in the Draw mode is
possible to "draw sounds" by running your finger(s) over the LED button matrix in various
ways.

[Reference]

« The note length (gate time) can be changed as required. (Sound Length — Page 25, 52)

As in the Score Mode the factory default scale for the vertical axis is an ionian scale,
corresponding to the white keys on a piano. Nothing is assigned to the horizontal axis, but
you can run your finger over the matrix horizontally to produce notes in quick succession.

[Reference]

+ Selecting a scale other than the ionian scale. (Master Scale — Page 44)

=+ Changing octaves. (Octave — Page 26)

=+ Changing the light animation. (Animation — Page 53)

Draw curves or shapes on the LED buttons. The sounds/lights of the drawn curve will repeat at a
pre-determined interval.

0000000000000

Pitch 9 O
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Low

0000000 000000
0000000000000
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The TENORI-ON Is ...

Performance Modes Bounce Mode

Bounce Mode

The Bounce Mode is assigned to layer 14.

Bounce Mode Operation

Press an LED button and the light will "drop" from that button, bounce back from the bottom
of the matrix, and repeat. The corresponding note will sound when the light bounces at the
bottom row.
The higher the entry point, the longer the interval between the sound. By choosing
appropriate entry points you can set the repeat interval as required.

[Reference]

+ The illuminated dots move at a speed corresponding to the timing of the LED buttons: i.e. 1 beat per dot.
(Loop Speed — Page 29, 51. Master Loop Speed — Page 45).

In the Bounce Mode the pitches are arranged horizontally. As in the Score Mode the factory
default scale is an ionian scale, corresponding to the white keys on a piano, with the lowest
pitch on the left and the highest on the right.
Press the lowest LED button to stop activity in that column.

[Reference]

=+ Selecting a scale other than the ionian scale. (Master Scale — Page 44)

=+ Changing octaves. (Octave — Page 26)

+ The note length (gate time) can be changed as required. (Sound Length — Page 25, 52)

Entry Point . .
The light will drop from the entry

point and sound at the bottom row.

Q Q00000
0 00000000
0 00000000
0000000

. Bounces between
Pitch the entry point

Bounces back and lowest row.
from the lowest
Note sounds at the lowest row.  ow.
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The TENORI-ON Is ...

Performance Modes Push Mode

Push Mode
The Push Mode is assigned to layer 15.

Push Mode Operation

In this mode if you press and hold an LED button the sound of the corresponding note will
begin to change gradually. The way the note changes will depend on the voice used (this
feature will only work with sustained voices that have a time-based tonal change in the
sustained portion of the voice’s envelope). Voices 15/01 through 15/16 have been
specifically created for use in the Push mode, and are recommended.

The flashing surrounding the pressed button will gradually get brighter and wider.

If the button is held briefly the note and flashing will stop when you release it, but if you hold
the button for longer the note and flashing will continue even after the button is released.

To stop a note that is sounding, press the corresponding LED button (at the center of the
flashing LED buttons).

The factory default scale for the horizontal axis is an ionian scale, corresponding to the white
keys on a piano. Nothing is assigned to the vertical axis.

[Reference]

= Selecting a scale other than the ionian scale. (Master Scale — Page 44)

= Changing octaves. (Octave — Page 26)

Hold an LED button and ... The flashing will expand.

©©©©©©©©©©©©©© 0000000000000

Pitch Sound/light (changing).

TENORI-ON Manual 20



The TENORI-ON Is ...

Performance Modes Solo Mode

Solo Mode
The Solo Mode is assigned to layer 16.

Solo Mode Operation

Press an LED button and the corresponding note will repeat until the button is released. The
LEDs in a column in which an LED button is pressed will flash upwards.
In the solo mode the pitches are arranged horizontally, like a piano. The vertical axis sets the
interval between repeats: you can change the interval between repeats easily by pressing or
sliding your finger to a lower (longer) or higher (shorter) LED button in the column.
If a sustained voice is used the note will sound for as long as the button is held.

[Reference]

+ The note length (gate time) can be changed as required. (Sound Length — Page 25, 52)

« The interval between repeats can be adjusted by changing the loop speed. The repeat interval of the top row
of LED buttons is 1/2 the loop speed, and the interval doubles for each row down the matrix. (Loop Speed —
Page 29, 51. Master Loop Speed — Page 45).

The factory default scale for the horizontal axis is an ionian scale, corresponding to the white
keys on a piano, with the lowest pitch on the left and the highest on the right.

[Reference]

=+ Selecting a scale other than the ionian scale. (Master Scale — Page 44)

=+ Changing octaves. (Octave — Page 26)

= Note timing in the Solo Mode will be synchronized to the Score Mode. (Quantize — Page 60)

Short 00000000 0000000 Note Repeat Timing
Left :I::I::I::I::I:\I::I::I::I:
I 1 1 I ™41 1 1 1
Repeat '
Interval P
. ] ] ] ] ]
Aot — B
Long

Time

If you press the lowest LED button in a column the note will
sound only once.
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Parameter Settings

Parameter Settings

The TENORI-ON provides the following two methods for setting parameters such as voice
and tempo.

mThe Function Buttons (— Page 23)

The function buttons are used in conjunction with the LED buttons to provide fast, easy
access to functions such as voice switching, layer switching, block switching, and more.
Visual feedback from the LED button matrix makes settings intuitive and easy.

mThe Jog Dial and Menu (— Page 36)

Detailed parameters, file save and load functions, song recording and other "deep" functions
can be accessed via the jog dial and menu. "Customization" functions such as long-press
time for the LED buttons can also be accessed and adjusted in this way.

©® Settings available via the function buttons ([L1] — [L5], [R1] — [R5]) also appear on the LCD display during
adjustment. At this time you can also use the jog dial for finer adjustment.
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Parameter Settings

Setting Parameters with the Function Buttons

Setting Parameters with the Function Buttons

Settings can be made by holding one of the ten function buttons located on either side of the
TENORI-ON ([L1] — [L5], [R1] — [R5]) and operating the LED buttons.
When a function button is pressed the current setting for that button will appear on the LED

button matrix, and the setting can be changed by pressing the appropriate LED button(s).

Settings available via the function buttons also appear on the LCD display during
adjustment. At this time you can also use the jog dial for finer adjustment.

Function Buttons

L
L2
s
L4
L5

LED Buttons

Function Buttons

-

Q IR
O ————IR2]
Q )
O R4
Q ——[Rs]

LCD Display

Jog Dial

The settings available via the function buttons are as follows:

Button Function Description Page
[L1] Instrument Selects the voice for the current layer. 24
[L2] Sound Length Sets the gate time (note length) for all active notes in the current layer. 25
[L3] Octave Sets the octave for all active notes in the current layer. 26

Loop Point (Score

Modpe) int (Scor Sets the loop range when a Score Mode layer is selected. 27
[L4]

Rotation (Random Sets the direction and speed of rotation for active note shapes in the Random o8

Mode) Mode.
(L5] Loop Speed Sets the beat length (the speed of the loop indicator) for Score Mode layers o9

only.

[R1] Layer No. Switches layers. 30
[R2] Master Tempo Sets the tempo for all layers and blocks. 31
[R3] Master Transpose Sets transposition for all layers and blocks. 32
[R4] Volume Sets the volume for each layer (common to all blocks). 33
[R5] Block No. Switches blocks. Also used for layer and block copy. 34
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Parameter Settings

Setting Parameters with the Function Buttons  [L1] Instrument

[L1] Instrument

Selects the voice for the current layer.
When you press and hold the [L1] button vertical and horizontal lines will light on the matrix,
and the button at their intersection corresponds to the currently selected voice. If you press a
different LED button while these crossed lines are showing the intersection will move to that
button and the corresponding voice will be selected.
Refer to the Voice List on Page 119 for a complete list of voice numbers and names.
Voice numbers <01/16>, <02/16>, and <03/16> are user voices.

® When a user voice is selected from a preset voice, the Sound Length (— Page 52) will be set to 1000 (msec).

Conversely, when a preset voice is selected from a user voice the sound length for all other voices will be set
to 100 (msec).

©® Changes will not be applied to notes that are already playing in the Push or Solo modes, or currently playing
notes if a long Sound length has been specified.

mRange............ Vertical axis: 01 — 16. Horizontal axis: 01 — 16
mDefault ........... Different for each layer
. 1] 00000000 00000000 O

L1

O

La

O

L3

O

La

O

LS

The intersection of the crossed lines is the current voice number
(in this example: <06/10>).

Instrument =] w
L J Current Layer Number

Voice Number Voice Name

[Reference]

= Layer menu/Instrument (— Page 49), Voice List (— Page 119)
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Parameter Settings

Setting Parameters with the Function Buttons  [L2] Sound Length

[L2] Sound Length

Sets the note length (gate time) for all active notes in the current layer.

While holding the [L2] button slide your finger horizontally over the matrix to move the lit
vertical line to the desired setting, or simply press an LED button at the appropriate column.
Moving the line to the right increases the note length.

The LED buttons adjust the Sound Length in the increments listed below. You can also use
the jog dial for finer adjustment in +/-10 millisecond increments.

© Depending on the voice used, setting a shorter Sound Length may have no effect, or changing the Sound
Length may result in inconsistent sound. Also, the maximum length of user voices is 0.97 seconds, and
setting a longer Sound length will have no effect.

mRange............ 10 msec — 9990 msec
m Default ........... 100 msec (all layers)

Values selected via the LED buttons.
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Matrix display related to settings made via the jog dial.
Sound Lenath =] W
Lawer Current Layer Number
e
\
Gate Time

[Reference]

=+ Layer menu/Sound Length (= Page 52)
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Parameter Settings

Setting Parameters with the Function Buttons [L3] Octave

[L3] Octave

Sets the octave for all active notes in the current layer.

While holding the [L3] button slide your finger vertically over the matrix to move the lit
horizontal line to the desired octave, or simply press an LED button in the appropriate row.
The eighth row from the bottom produces no octave shift (a "0" setting). Each row above that
shifts the pitch up by the corresponding number of octaves up to "+5", while each row below
that lowers the pitch by the corresponding number of octaves down to "-5". Pressing an LED
button outside the maximum octave shift range of -5 — +5 has no effect.

® Changes will not be applied to notes that are already playing in the Push or Solo modes, or currently playing
notes if a long Sound length has been specified.

mRange............ -5 — +5 octaves
m Default ........... 0 (all layers)

SHbhbbio

'O O @ O O
HOMHON O OO

Oztawve EIW

Lager m J Current Layer Number

Octave Shift
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Parameter Settings

Setting Parameters with the Function Buttons [L4] Score Mode Loop Point

[L4] Score Mode Loop Point

Sets the loop playback range for the current Score Mode layer.

While holding the [L4] button slide your finger horizontally over upper half of the matrix to
move the loop TOP point indicator to the desired point, and slide your finger horizontally over
lower half of the matrix to move the loop END point indicator to the desired point, as
required. Once the start and end points are set you can use the jog dial to move the entire
range to the left or right while maintaining the set distance between the start and end points.

©® The END point cannot be moved to a position before (to the left of) the TOP point. The END point can be
moved to the same location as the TOP point, which will produce a 1-beat loop.

©® The loop points for all Score Mode layers can be set to the same points simultaneously via the Master Loop
Point (all layers) setting in the Play menu.

mRange............ TOP=1—16,END =1—16
mDefault ........... TOP = 1,END = 16

TOP Point END Point

O
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a
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a
n

Current Layer Number

TOP Point END Point

[Reference]

+ Play menu/Master Loop Point (= Page 46)
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Parameter Settings

Setting Parameters with the Function Buttons  [L4] Random Mode Rotation

[L4] Random Mode Rotation

When a Random Mode layer is selected you can spin loop-shapes by holding the [L4] button
and running a finger around the matrix in the direction and at the speed of the desired spin.

© Rotation direction and speed settings apply to the same layer in all blocks.

© To stop rotation, press and hold the LED button, or press the same LED button twice while holding the [L4]
button. Pressing the [CLEAR] button clears only the active notes, leaving the rotation data active unless
rotation has been stopped.

© Individual notes cannot be entered or cleared by pressing their LED buttons during rotation.

mRange............ The speed at which the LED buttons are stroked is detected, and the nearest rotation
speed” is automatically selected from the eight listed below.

4 beats (384 clocks),
3 beats (288 clocks),
2 beats (182 clocks),
1 beat (96 clocks),
3/4 beat (72 clocks),
1/2 beat (48 clocks),
1/4 beat (24 clocks),
1/8 beat (12 clocks)

* Rotation speed: Each complete rotation consists of 32 steps, and thus each step covers
an angle of 11.25°. Rotation speed is specified as the number of beats between steps.

[Reference]

+ The length of each beat can be adjusted via the Loop Speed parameter (Loop Speed — Page 29, 51. Master
Loop Speed — Page 45).

m Default ........... none
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Eotation =]
LagerlB2] [Randoml

Current Layer Number

[Reference]
+ Random Mode (— Page 17)
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Setting Parameters with the Function Buttons [L5] Loop Speed

[L5] Loop Speed

Sets the loop playback speed (the duration of the beats).
When the [L5] buttons is pressed the LED button column corresponding to the current
setting will light. Four settings are available, set via the leftmost four columns on the matrix:
quarter notes, eighth notes, sixteenth notes, and thirty-second notes.
While holding the [L5] button press a button in the corresponding column. LED buttons in
other columns have no effect.

© Not available in the Push Mode.

© This setting will be changed if the Master Loop Speed (all layers) parameter in the Play menu is changed.

mRange............ 1 (quarter note), 2 (eighth note), 4 (sixteenth note), 8 (thirty-second note)
mDefault ........... 4 (The layer 14 default is 8)
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Loop Speed =] W
Lagerlai Current Layer Number
\
Loop Speed

[Reference]

=+ Play menu/Master Loop Speed (— Page 45), Layer menu/Loop Speed (— Page 51)
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Setting Parameters with the Function Buttons [R1] Layer No.

[R1] Layer No.

Switches to a different layer.

When the [R1] button is pressed the LED button row corresponding to the currently selected
layer will light. The lowest row corresponds to layer 1 and the highest row corresponds to
layer 16.

While holding the [R1] button slide your finger vertically over the matrix or simply press an
LED button in the appropriate row to select the desired layer.

The selected layer number will also appear in the LCD display, along with the layer mode.

'O O O O O
HOMHON O OE( |

Lager Mo,

Layer Number

Mode Name

m
N
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Setting Parameters with the Function Buttons [R2] Master Tempo

[R2] Master Tempo

Sets the playback tempo for all layers and all blocks.

When the [R2] button is pressed the LED button column corresponding to the current tempo
setting will light. While holding the [R2] button slide your finger horizontally over the matrix or
simply press an LED button in the appropriate column to select the desired tempo setting.
Moving the line to the right produces faster tempos.

The LED buttons adjust the tempo in the increments listed below. You can also use the jog
dial for finer adjustment.

mRange............ 40 — 240 (50 — 200 via the LED buttons)

Values selected via the LED buttons.
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Matrix display related to settings made via the jog dial.

Master Tempo =]
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[Reference]

= Play menu/Master Tempo (— Page 43)
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Setting Parameters with the Function Buttons [R3] Master Transpose

[R3] Master Transpose

Adjusts the playback pitch in semitone increments for all layers and all blocks.

When the [R3] button is pressed the LED button row corresponding to the currently selected
transpose value will light. While holding the [R3] button slide your finger vertically over the
matrix or simply press an LED button in the appropriate row to select the desired degree of
transposition.

The eighth row from the bottom produces no transposition (a "0" setting). Each row above
that shifts the pitch up by the corresponding number of semitones up to "+8", while each row
below that lowers the pitch by the corresponding number of semitones down to "-7".

©® Changes will not be applied to notes that are already playing in the Push or Solo modes, or currently playing
notes if a long Sound length has been specified.
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[Reference]

# Play menu/Master Transpose (— Page 45)
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Setting Parameters with the Function Buttons [R4] Volume

[R4] Volume

Layer Volume

Allows the volume of each layer to be adjusted as required (layer volume common to all
blocks).

When the [R4] button is pressed the current volume settings for all 16 layers are displayed
on the LED button matrix. Each row of LED buttons corresponds to layer, beginning with
layer 01 at the bottom row.

While holding the [R4] button slide your finger horizontally over the row corresponding to the
layer you want to adjust to set the volume as required. Moving a setting to the right increases
the volume of the corresponding layer.

Master Volume

You can also use the jog dial while holding the [R4] button to set the master volume level (all
layers). The master volume value appears on the LCD display only.

mRange............ Layer volume: 0 — 127
Master volume: 0 — 127

mDefault ........... Layer volume: 96 (all layers)
Master volume: 96

The volume value set via the LED buttons.
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Yalume =]
Lager[B1]1 ‘96— Current Layer Volume
Master )
\

Master Volume

© To adjusts the instrument's basic volume level, refer to Hardware Volume (— Page 43).

[Reference]

= Layer menu/Volume (— Page 50)
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Setting Parameters with the Function Buttons  [R5] Block Number

[R5] Block Number

Switches to a different block.

When the [R5] button is pressed the LED button column corresponding to the currently
selected bock will light. The leftmost column corresponds to block 1 and the rightmost
column corresponds to block 16.

While holding the [R5] button slide your finger horizontally over the matrix or simply press an
LED button in the appropriate column to select the desired block.

® When switching blocks while in the Push Mode the active notes will be retriggered (i.e. they will play from the
beginning again).

® When switching blocks while in the Random Mode, Bounce Mode, the loop point will return to the beginning
of the loop in either of the cases listed below:
* The block that is switched to is not operating in one of the three modes listed above.
* The block that is switched to includes one or more notes in different positions from the current block.
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Setting Parameters with the Function Buttons  [R5] Block Number

Using the [R5] Button to Copy Layers

By holding the [R5] button and performing the operations described below you can copy
either a single layer or all layers from the current block to another block.

1.

If the current block is not the block containing the layers you want to copy, hold the
[R5] button and press the LED button corresponding to the desired "source" Block (the
LEDs in that column will light dimly).

If you repeatedly press the lowest LED button in the lit column while holding the [R5]
button, the LED buttons in the lit column will switch between three levels of brightness
in the following sequence: dim — medium — bright — dim. The functions
corresponding to each brightness level are: dim = block move, medium = copy 1 layer,
bright = copy all layers. The procedures to copy 1 or all layers are described below.

To Copy a Single Layer

While holding the [R5] button while the LED buttons are lit dimly, press the lowest LED
button in the lit column once so that the LED buttons shine at medium brightness, and
then press an LED button in column corresponding to the block you want to copy to.
The current layer from the source block will be copied to the same layer in the
destination block. Release the [R5] button.

To Copy All Layers

While holding the [R5] button while the LED buttons are lit dimly, press the lowest LED
button in the lit column twice so that the LED buttons shine at maximum brightness,
and then press an LED button in column corresponding to the block you want to copy
to. All layers from the source block will be copied to the destination block. Release the
[R5] button.

When the copy operation is complete the destination block will be selected and the
LED buttons will automatically return to their minimum brightness level.

TENORI-ON Manual
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Setting Parameters with the Jog Dial Basic Operation

Setting Parameters with the Jog Dial

In addition to using the function buttons described in the preceding section, parameters can
be accessed by using the jog dial and menus shown on the LCD display, and edited by
using the jog dial or LED buttons.

Basic Operation

1 When the power is turned on the status display will appear on the LCD following the
initial startup display.

Startup Display

TERMNORI-OMN =
TOSHIO IWAT & YAMAHA
Vel =, M

Status Display

MG -Score  FNRE]
[RE#E1 fE] Photon
TIME SRt si-pac]|

2 you rotate the jog dial while the status information is showing the Main Menu will
appear.

Main Menu

[Main menul =]

3. (NEENTT——

The currently selected item is highlighted on the display.
The Main Menu includes the following nine items:

No. Menu Description Page
1 Play menu Parameters common to all layers and blocks. 42
2 Layer menu Parameters that can be set individually for each layer. 48
3 Editmenu Copy, clear, reset, and other editing commands. 54
4 Preference menu Initial settings for the entire instrument. 59
5 File menu Data file save and load. 62
6  Effect menu Reverb and chorus effect settings. 99
7 Interior menu Non-performance operations (clock, song playback). 101
8  System menu Factory reset, SD Memory Card format, and others. 106
9 Recording menu Song record and save. 109

TENORI-ON Manual 36



Parameter Settings

Setting Parameters with the Jog Dial Basic Operation

3 Rotate the jog dial to select the desired menu item, and then press the [OK] button to go
to the related submenu.

[Main menul =]

@. (EENEITE—— o

v

The Play Menu Submenu

[Flag menul =]

. o e R Y W

4 Selecta parameter from the submenu and press the [OK] button to go to the related
parameter edit display.

[Flag menul =]

Vv

Hardware Volume Parameter Display

Hardware Yolume =]

O oK O CANCEL

© The File menu submenu contains a further layer of operations from which the desired operation must
be selected. See "File menu" on Page 62 for details.

5 Inthe parameter edit display the current parameter value will be highlighted ready for
editing. Use the jog dial to edit the parameter as required. Some parameters can be set
via the LED buttons.

Hardware Yolume

E i
I . ‘E‘ ox (emea

Parameter Value
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Setting Parameters with the Jog Dial Basic Operation

Press the [OK] button to apply the edit and return to the previous menu layer.
Press the [CANCEL] button to return to the previous menu layer without making any
changes.

© If a parameter edit display includes multiple parameters, pressing the [OK] button after editing one
parameter will apply that edit and highlight the next parameter in the display.

Arnimation =]

L%uer[gﬂi
HEe .
5 | = ‘_‘.\{pand . oK O CANCEL

7

Adrnimation =]
Lagerl@l ]

Tore  Cjrcle

Size: Expand

7 Usethe [CANCEL] button to navigate upward through the menu layers.
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Data Storage and Initialization

Data that is Erased When the Power is Turned Off

m All block set

All active notes and settings for all layers and blocks are not retained in memory when the
power is turned off, so if you want to keep any active notes data you have created you will
need to use the Save All Blocks function described on Page 69 to save it to an SD Memory
Card.

m Data Listed as "Save as Default" in the "Backup" Column of the Chart Below

These items are not retained in memory when the power is turned off, but can be saved to
the internal flash ROM as the default settings by using the Save As Default function
described on Page 106. Settings saved in this way become the power-on default settings.

Items listed as "Automatic Backup" in the "Backup" column of the chart are automatically
saved as the power-on default settings whenever a change is made.

Initialization

The entire system can be restored to the factory default settings by using the Factory Reset
function described on Page 108. To reset all active notes and settings for all layers and
blocks, use the Reset All Blocks function described on Page 58.

& All data will be erased when the Factory Reset function is executed. Be sure to save any data you want
to keep to an SD Memory Card beforehand.

A All layer and block data will be erased when the Reset All Blocks function is executed. Be sure to save
any data you want to keep to an SD Memory Card beforehand.

Menu Settings

Parameter Backup Factory Default

Play Menu Hardware Volume Automatic Backup 96
Master Tempo 75
Master Scale Save As Default lonian
Master Transpose 0

Cannot be backed up.
But since this setting is
related to the Layer menu
Master Loop Speed Loop Speed parameter, it 4
can be saved as the default
layer setting by using the
Save As Default function.

TOP Cannot be backed up. 1
But since this setting is
related to the Loop Point
settings accessed via the
END function buttons, it can be 16
saved as the default layer
setting by using the Save As
Default function.

Master Loop Point

Reset Loop Timing Cannot be backed up. OK
Mute Save As Default OFF
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Parameter Backup Factory Default
Layer Menu Layer 1 01/01

Layer 2 02/15

Layer 3 03/01

Layer 4 04/08

Layer 5 05/03

Layer 6 06/10

Layer 7 07/10
Instrument Layer 8 08/05

Layer 9 09/01

Layer 10 10/13

Layer 11 1112

Layer 12 12/01

Layer 13 13/01

Layer 14 14/04

Layer 15 15/02

Layer 16 16/02
Volume Layer 1 — 16 96
Loop Speed Layer 1 — 16 4 (The layer 14 default is 8)
Sound Length Layer 1 — 16 100
Panpot Layer 1 — 16 CENTER

Type Layer 1 Circle

Size Layer 1 3

Expand/Shrink Layer 1 Expand

Type Layer 2 Square

Size Layer 2 3

Expand/Shrink Layer 2 Expand

Type Layer 3 Diamond

Size Layer 3 4

Expand/Shrink Layer 3 Shrink

Type Layer 4 Save As Default Cross

Size Layer 4 3

Expand/Shrink Layer 4 Expand

Type Layer 5 Plus

Size Layer 5 3

Expand/Shrink Layer 5 Expand

Type Layer 6 Circle

Size Layer 6 4

Expand/Shrink Layer 6 Shrink

Type Layer 7 Diamond
Animation Size Layer 7 5

Expand/Shrink Layer 7 Expand

Type Layer 8 Circle

Size Layer 8 4

Expand/Shrink Layer 8 Expand

Type Layer 9 Square

Size Layer 9 3

Expand/Shrink Layer 9 Shrink

Type Layer 10 Diamond

Size Layer 10 4

Expand/Shrink Layer 10 Expand

Type Layer 11 Plus

Size Layer 11 6

Expand/Shrink Layer 11 Shrink

Type Layer 12 Circle

Size Layer 12 5

Expand/Shrink Layer 12 Expand

Type Layer 13 Square

Size Layer 13 4

Expand/Shrink Layer 13 Expand
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Setting Parameters with the Jog Dial

Function Button Settings

Parameter Backup Factory Default
Layer Menu Expand/Shrink Layer 14
Type Layer 15
Size Layer 15
Animation Expand/Shrink Layer 15 Save As Default Expand/Shrink
Type Layer 16 Vertical Line
Size Layer 16
Expand/Shrink Layer 16
Edit Menu - - -
Preference Menu | Quantize ON
Push Sensitivity 120
Master Tuning 0
Automatic Backup
Local Control ON
Synchronize MASTER
Loop Indicator ON
File Menu - - -
Effect Menu Reverb Type HALL1
Reverb Param 40
Automatic Backup
Chorus Type NO EFFECT
Chorus Param 0
Interior Menu Interior START - -
Interior Type Song (DEMO)
Saver Type Interior
Saver Time 10
Time Signal On/Off Automatic Backup OFF
Alarm On/Off
Hour
Set Alarm 0
Minute
Save As Time Signal
None -
Save As Alarm
Year 07
Month Automatic Backup
Day (When the clock battery is o1
Clock Adjust depleted the clock will be
Hour reset to '07/01/01 00:00:00")
Minute 0
Second
System Menu Save As Default
SD Format
Owner Name Automatic Backup “No Name”
Version Check
Factory Reset - -
Recording Menu -
Parameter Backup Factory Default
Common Layer No 1
Block No 1
Master Volume 96
Save As Default
Layer Octave Layer 1 — 16 0
TOP Layer 1 — 16 1
Loop Point
END Layer 1 — 16 16
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M Play Menu

The Play menu provides access to performance parameters that apply all layers and alll
blocks.
The Play menu submenu includes the following 8 items.

1. Hardware Volume Page 43
2. Master Tempo Page 43
3. Master Scale Page 44
4. Master Transpose Page 45
5. Master Loop Speed Page 45
6. Master Loop Point Page 46
7. Reset Loop Timing Page 46
8. Mute Page 47

Use the jog dial to highlight a submenu item, then press the [OK] button to go to the
corresponding parameter edit display.

[Flag menul =]

aster cale .DK QCANCEI_
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Setting Parameters with the Jog Dial M Play Menu

1. Hardware Volume

Hardware Yolume =]

ER

Sets the hardware volume.
mRange............ 0—127
mDefault ........... 96
mLED Buttons . ... ... No display

[Reference]

= Layer menu/Volume (— Page 50)
2. Master Tempo

Master Tempo =]
EFH : IEE

Sets the master tempo for all layers and blocks.

This display also appears when the [R2] button is pressed.

The LED buttons can be used to make adjustments in the increments shown below, while the
jog dial can be used for fine adjustment.

mRange............ 40 — 240
m Default ........... 75
mLEDButtons . .... .. Values are displayed on the LED button matrix as illustrated below. Adjustments can be

made via the LED buttons from 50 to 200 in 10-step increments.

Tempo settings available via the LED buttons.

jejeojejojololojolojolojojololoNe]
PONOOOTANNITLOE0RY
0/00/00]0/0)0 000000ee
00000000 00000000
0/00/0000© 00000000
0/0/0/00/00/0 0.0.00000.e)
©/0/0/00)00© 00000000
©/0/0/0000© 00000000
00000000 00.00000.e)
00000000 000000ee
@]0/000[0/00 0000000
00000000 00.0000.0.e)
0/0/0/0/0/0.0/0 00000000
©/00/0000© 00000000
©/00/00)00© 00000000
0/0/0/0/0/0.0/0 0.0.00000.e)
©/00/0000© 00000000
©/0/0/00)0/0/0 00/00000e)
88R2838288938288%
Orrr e T T T T T T T
FTWOOMNMNO T ™ ™ 7™ 7T YT T T T T

DO~ ANMITHON0D

P e = —

LED button matrix display in relation to tempo settings made via the jog dial.

[Reference]

=+ Function Button [R2] (= Page 31)
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3. Master Scale

Master Scale =]

Sets the master scale for all layers and blocks.

©® Changes will not be applied to notes that are already playing in the Push or Solo modes, or currently playing
notes if a long Sound length has been specified.

mRange............ lonian, Dorian, Phrygian, Lydian, Mixolydian, Aeolian, Locrian, Chromatic, OKINAWA
mDefault ........... lonian
m LED Buttons . ... ... No display

Note Assignments for Each Scale

Octave = 0, Transpose = 0, Center Note = C3

lonian Dorian Phrygian Lydian | Mixolydian | Aeolian Locrian Chromatic OKINAWA 16
D5 (86) | D5(86) | Di5(85) | D5(86) | D5(86) | D5(86) | Db (85) | D#/Er4 (75) | C6 (96) n 00000000 0[00000ee
C5(84) | C5(84) [ C5(84) [ C5(84) | C5(84) | C5(84) | C5(84) D4 (74) B5 (95) 00000000 00000eee
B4 (83) | B4 (82) | B4 (83) | B4(83) | B4 (82) [ Br4(82) | B4 (82) | C/Dw4(73) | G5 (91) 00000000 00000eee
A4(81) | A4(81) | A4 (80) | A4(81) | A4(81) [ AM(80) | A4(80) | ca(2) [ F5(89) | + (OOOOO0O0O000O0O000Q
G4(79) | G4(79) | G4(79) | G4(79) | G4 (79) | G4 (79) | G4 (78) B3 (71) E5 (88) 00000000 0000000
Fa(77) | Fa(77) | F4(77) | Fe4(78) | F4(77) | F4(77) | F4(77) | A3/B3(70) | C5(84) N 00000000 00000000
E4(76) | B4 (75) | Ex4(75) | E4(76) | E4(76) | E#4 (75) | Er4 (75) A3 (69) B4 (83) 0000000000000 ee
D4 (74) | D4 (74) | D4 (73) [ D4 (74) | D4 (74) | D4(74) | Dw4(73) | GI3/AR3 (68) | G4 (79) 00000006 e0000eeee
C4(72) | C4(72) | C4(72) | C4a(72) | C4(72) | C4(72) | C4(72) G3 (67) F4 (77) N 0000000000000 eee
B3(71) | B3 (70) [ B¥3(70) [ B3(71) | B3 (70) | BK3(70) | B¥3(70) | F3/G¥3 (66) | E4 (76) 00000000 0000000
A3 (69) | A3(69) | A:3(68) | A3(69) | A3(69) | Ai3(68) | Ai3(68) F3 (65) C4 (72) N 0000000000 eeee
G3(67) | G3(67) | G3(67) | G3(67) | G3(67) | G3(67) | G*3(66) E3 (64) B3 (71) 00000000 00000eee
F3(65) | F3(65) | F3(65) | Fi3(66) | F3(65) | F3(65) | F3(65) D:3/E'3 G3 (67) N 00000000 00000eee
E3(64) | E/3(63) | E:3(63) | E3(64) | E3(64) | E:3(63) | EX3(63) D3 (62) F3 (65) 0000000000000 ee
D3(62) | D3(62) | D:3(61) | D3(62) | D3(62) | D3 (62) | DB(61) | CHIDIB(61) | ES(64) | 00000000 000e0ee.)
C3(60) | C3(60) | C3(B0) | C3(60) | C3(60) | C3(60) | C3(60) C3 (60) C3 (60) 00000000 000eeee.)
Ct Dt Ft Gt A
DE G A B
h
7
V
3 ,_,_!—'I'_-:
ANIV4
dJ o
C DEF G ABGC

CDEFGABC
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Setting Parameters with the Jog Dial M Play Menu

4. Master Transpose

Master Transpose =

Sets transposition for all layers and blocks.
This display also appears when the [R3] button is pressed.

© Changes will not be applied to notes that are already playing in the Push or Solo modes, or currently playing
notes if a long Sound length has been specified.

mRange............ -7 — +8 (semitone increments)
mDefault ........... 0
mLEDButtons .. ... .. Values are displayed on the LED button matrix as illustrated below. Adjustments can be

made via the LED buttons.

Nohbhbbio

0CO00000COO00OOO

The eighth row from the bottom produces no transposition (a "0" setting). Each row above that
shifts the pitch up by the corresponding number of semitones up to "+8", while each row below
that lowers the pitch by the corresponding number of semitones down to "-7".

[Reference]

= Function Button [R3] (= Page 32)

5. Master Loop Speed

Master Loopr Spesd (=

Sets the loop speed (the length of each beat) for all layers and blocks.

mRange............ 1 (quarter note), 2 (eighth note), 4 (sixteenth note), 8 (thirty-second note)
mDefault ........... 4
mLED Buttons . ... ... No display

[Reference]

=+ Layer menu/Loop Speed (— Page 51)
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Setting Parameters with the Jog Dial M Play Menu

6. Master Loop Point

Master Loor Point (=

TOP: 5 ¢ EHD:1‘5

TOP Position  END Position

Sets the loop points (TOP and END) for all layers and blocks.

The loop includes the TOP and END points.

The TOP and END points are set via the LED buttons, and the jog dial moves the entire loop
range backward or forward.

® The END point cannot be moved to a position before (to the left of) the TOP point. The END point can be
moved to the same location as the TOP point, which will produce a 1-beat loop.

mRange............ TOP=1—16,END =1— 16
mDefault ........... TOP = 1,END = 16
mLED Buttons . . ... .. The TOP point is indicated by a lit half-column on the upper half of the matrix, and the END

point is indicated by a lit half-column on the lower half of the matrix, as shown below. The
TOP and END points are set via the LED buttons.

TOP Point END Point

[Reference]

s Function Button [L4] (= Page 27)

7. Reset Loop Timing

Eeset Loor Timing =

Resets the current playback position to the TOP of the loop for all layers and blocks.

mRange............ OK, CANCEL
m Default ........... OK
mLEDButtons .. ... .. No display
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Setting Parameters with the Jog Dial M Play Menu

8. Mute

Mute =]

All sound output is muted when this function is turned ON.

mRange............ ON, OFF
mDefault ........... OFF
mLED Buttons . ... ... No display
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Setting Parameters with the Jog Dial M Layer Menu

M Layer Menu

The Layer menu provides access to parameters that apply to individual layers.
The currently selected layer will be affected by the Layer menu parameters.
The Layer menu submenu includes the following 6 items.

1. Instrument Page 49
2. Volume Page 50
3. Loop Speed Page 51
4. Sound Length Page 52
5. Panpot Page 53
6.  Animation Page 53

Use the jog dial to highlight a submenu item, then press the [OK] button to go to the
corresponding parameter edit display.

[Lager menul =]

fulw =] [=1=1=] . oK O CANCEL
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Setting Parameters with the Jog Dial M Layer Menu

1. Instrument

Instrument =] W
L J Current Layer Number

Voice Number Voice Name

Selects the voice that will be played in the current layer.

This display also appears when the [R1] button is pressed.

Refer to the Voice List on Page 119 for a complete list of voice numbers and names.
Voice numbers <01/16>, <02/16>, and <03/16> are user voices.

® When a user voice is selected from a preset voice, the Sound Length (— Page 52) will be set to 1000 (msec).
Conversely, when a preset voice is selected from a user voice the sound length for all other voices will be set
to 100 (msec).

©® Changes will not be applied to notes that are already playing in the Push or Solo modes, or currently playing
notes if a long Sound length has been specified.

mRange............ Vertical axis: 01 — 16
Horizontal axis: 01 — 16
m Default ........... Different for each layer
mLEDButtons .. ... .. The current voice is indicated by the intersection of the lit row and column. The LED buttons

can be used to select a different voice.

@ 0000000 00000000

TANTOVONODNDO T~ ANMIT OO
OO0 O0O0O0O0OO0OO0O T+

The intersection of the crossed lines is the current voice number
(in this example: "06/10").

[Reference]
= Function Button [L1] (= Page 24), Voice List (= Page 119)
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Setting Parameters with the Jog Dial M Layer Menu

2. Volume

Volume =] W
Lagerl Eﬁ J Current Layer Number

Volume

Sets the volume of individual layers (layer volume common to all blocks).

LED button matrix display and operation are the same as for the [R4] button.

The LED buttons can be used to set the volume of all 16 layers.

The LED buttons adjust the volume in the increments shown below, while the jog dial can be
used for fine adjustment.

mRange............ 0—127
m Default ........... 96 (all layers)
mLED Buttons . ... ... Each row of LED buttons corresponds to a layer, while the horizontal axis corresponds to

volume level (refer to the illustration below). The LED buttons can be used to adjust the
volume of the corresponding layer.

The volume value set via the LED buttons.

Layer Number

LED button matrix display in relation to layer volume settings made via the jog dial.

[Reference]
= Function Button [R4] (— Page 33)
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Setting Parameters with the Jog Dial M Layer Menu

3. Loop Speed

Loop Sp

ced =] w
Lagerl@l

J Current Layer Number

\
Loop Speed

Sets the loop playback speed (the duration of the beats).
This display also appears when the [L5] button is pressed.

©® This setting will be changed if the Master Loop Speed (all layers) parameter in the Play menu is changed.

mRange............ 1 (quarter note), 2 (eighth note), 4 (sixteenth note), 8 (thirty-second note)
m Default ........... 4 (The layer 14 default is 8)
mLED Buttons . ... ... The leftmost four columns on the matrix correspond to the available settings: quarter notes,

eighth notes, sixteenth notes, and thirty-second notes.
Press an LED button in one of these columns to make the corresponding setting.
LED buttons in other columns have no effect.

0000000000000

CO0000OOOO000OO

— AN < O

Settings are indicated by a lit column.

[Reference]

=+ Play menu/Master Loop Speed (— Page 45), Function Button [L5] (— Page 29)
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Setting Parameters with the Jog Dial M Layer Menu

4. Sound Length

Sound Lenath =] W
Lager

Current Layer Number
m=ec:

\
Gate‘ Time

Sets the note length (gate time).
This setting applies to all active notes in the current layer.
The LED buttons adjust the Sound Length in the increments listed below. You can also use
the jog dial for finer adjustment in +/-10 millisecond increments.
This display also appears when the [L2] button is pressed.

©® Depending on the voice used, setting a shorter Sound Length may have no effect, or changing the Sound

Length may result in inconsistent sound. Also, the maximum length of user voices is 0.97 seconds, and
setting a longer Sound length will have no effect.

mRange............ 10 msec — 9990 msec
mDefault ........... 100 msec (all layers)
mLED Buttons . ... ... The selected values are displayed as illustrated below. Settings can also be made via the

LED buttons.

=+
e}
>
12}

Values selected via the LED bu

O
@)
O

0-500 (OO0
0-600 (OOOO
0-2000 (OO0
0-3000 [OOOOO!
0-4000 (OO0
0-5000 (OO0
0-6000 (OO
0-8000 (OO
0-9990 (OO

8
10
20
30
40
50
60
80

Matrix display related to settings made via the jog dial.

[Reference]
+ Function Button [L2] (= Page 25)
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Setting Parameters with the Jog Dial

5. Panpot

W Layer Menu

Fanpot EIW

Lagerl &]!_,iﬁgi J Current Layer Number

Panpot

Sets the stereo pan position for the current layer.

mRange............ L64 — LO1, CENTER, RO1 — R63
m Default ........... CENTER (all layers)
mLED Buttons . ... ... No display

6. Animation

Current Layer Number

drnimation J =]
Laqgerl
Tape ?i%ﬂi Animation Type
Size: wrand J

Maximum Size

- 1] ‘

Expand/Shrink

Sets the type of light animation that accompanies active notes, including whether the

animation expands or shrinks, and the maximum animation size.
These settings apply to the current layer.

mRange............ Type: Simple Circle Square
DUUULAI A osssssisesss o s
0000000 20000000C
DT 3OO0 olelelelee(ed
hlee 00000 000000O( 000000OC
)lelole0 000 000000QO( 20000000C
30000000 000000( 20000000C
00000004 00000 0000000C
3000000 belesloslo boleslelelsls
Diamond Cross Plus
)[0/0/0/0/0/0/0 2000000 1]6/0,6,0,0/0/0 4
Sesr Ry e
2000000 20000000 2000000
2000000 20000000
2000000 20000000 %88888882
e sloslo: peloeosie’ peoeleeielel

Size: 1 — 22 (maximum expand or shrink size), Expand, Shrink
mDefault ........... Different for each layer
mLED Buttons . ... ... No display
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M Edit Menu

The Edit menu provides access to data editing functions such as copy, clear, and reset.
The Edit menu submenu includes the following 6 items.

1. Copy this Block Page 55
2. Clear this Block Page 55
3. Copy this Layer Page 56
4. Clear this Layer Page 57
5. Clear All Blocks Page 57
6. Reset All Blocks Page 58

Use the jog dial to highlight a submenu item, then press the [OK] button to go to the
corresponding parameter edit display.

The Undo Function

When you press the [OK] button to execute a copy, clear, or reset function from the Edit
menu, the "UNDOQ" display shown below will appear after the copy, clear, or reset function
has been completed. To undo the function just executed press the [OK] button, or to
continue without undoing the function press an LED button or the [CANCEL] or [CLEAR]
button.

@ Oovem

® The UNDO display will time-out after 15 seconds if no operation is performed in that time.

© The Undo display will not appear when the [CLEAR] button is pressed (short or long press) to clear all
active notes from the layer.
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1. Copy this Block

Current Block Number

1
ock . [EE J (the copy source)

Copy Destination Block Number

Copy all active notes from all layers in the current block to a different block.
Specify the destination block number and then press the [OK] button.
Press the [CANCEL] button to cancel the copy operation.

mRange............ 1—16

mLEDButtons .. ... .. The copy destination block number is displayed as illustrated below.
The destination block number can also be set via the LED buttons.

Copy Destination Block Number

2. Clear this Block

Clear this Block & )
El oz J Current Block Number

(the block to be cleared)

Clears all active notes from all layers in the current block.
Rotate the jog dial to display "OK" if it isn’t already showing, then press the [OK] button.
To cancel the clear operation either press the [CANCEL] button or rotate the jog dial to
display "CANCEL" and press the [OK] button.
© This function clears the active notes, but leaves Random Mode rotation data unaffected and active. The LED

buttons can not be used to enter notes while rotation is active. Refer to Rotation (= Page 28) for information
on stopping rotation.

mRange............ OK, CANCEL
m Default ........... OK
mLED Buttons . ... ... Animation displayed when clear executed
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3. Copy this Layer

Current Block Number

Current Layer Number (the copy source)

Copa this Lager = ) Copy Destination Block Number
Elock(g]] Caseri@ll | |
Lest. Block: B2 o
Dest. Lager: A1 g Copy Destination Layer Number

Copies all active notes from the current layer in the current block to a layer in a different
block. This function will only work between layers that have the same performance mode.

Example: You can copy from layer 1 (Score Mode) to layer 7 (Score Mode), but from layer 1
(Score Mode) to layer 8 (Random Mode).

Use the LED buttons to select the copy destination block and layer numbers (you can also
use the jog dial to select the copy destination block).

When the destination block and layer have been selected, press the [OK] button to execute
the copy operation.
Press the [CANCEL] button to cancel the operation.

© If the copy source layer has a different performance mode from the destination layer, the "Mode different.
Can't copy!" message will appear. Press either the [CANCEL] or [OK] button to return to the Edit menu.

mRange............ Destination Block: 1 — 16,
Destination Layer: 1 — 16
mDefault ........... The currently selected block and layer
mLED Buttons . ... ... The columns correspond to block numbers and the rows correspond to layer numbers as

illustrated below. The intersection between the lit horizontal and vertical lines indicates the
destination block and layer numbers.

In this example the selected copy destination block 2, layer 7.

Copy Destination Layer Number

00000
0 00000000

@@

@

QO
06 0000 00000000
05 000 00000
04 000000000000
03 0000 00000000
02 000000000000
01 00000000000

5983885832 NerRe

Copy Destination Block Number
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4. Clear this Layer

Current Block Number

Current Layer Number (the layer to be cleared)

CElﬁar this Lauer[a\ﬁl
uckiﬂgg hauer

Clears all active notes from the current block and layer. This produces the same result as
briefly pressing the [CLEAR] button.
Rotate the jog dial to display "OK" if it isn’t already showing, then press the [OK] button.
To cancel the clear operation either press the [CANCEL] button or rotate the jog dial to
display "CANCEL" and press the [OK] button.

© This function clears the active notes, but leaves Random Mode rotation data unaffected and active. The LED

buttons can not be used to enter notes while rotation is active. Refer to Rotation (= Page 28) for information
on stopping rotation.

mRange............ OK, CANCEL
mDefault ........... OK
mLED Buttons . ... ... Animation displayed when clear executed

5. Clear All Blocks

Clear &l Blocks =
| 0K |

Clears all active notes from all blocks and layers. This produces the same result as pressing
the [CLEAR] button (long press).

Rotate the jog dial to display "OK" if it isn’t already showing, then press the [OK] button.

To cancel the clear operation either press the [CANCEL] button or rotate the jog dial to
display "CANCEL" and press the [OK] button.

mRange............ OK, CANCEL
mDefault ........... OK
mLED Buttons . ... ... Animation displayed when clear executed

TENORI-ON Manual 57



Parameter Settings

Setting Parameters with the Jog Dial M Edit Menu

6. Reset All Blocks

[Eeset a1 Blocks EI}
(1]

Clears all active notes and initializes all settings for all blocks and layers.

Rotate the jog dial to display "OK" if it isn’t already showing, then press the [OK] button.
To cancel the clear operation either press the [CANCEL] button or rotate the jog dial to
display "CANCEL" and press the [OK] button.

mRange............ OK, CANCEL
mDefault ........... OK
mLEDButtons .. ... .. Animation displayed when reset executed
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M Preference Menu

The Preference menu provides access to initial settings that apply to the entire instrument.
The Preference menu submenu includes the following 6 items.

1. Quantize Page 60
2. Push Sensitivity Page 60
3. Master Tuning Page 60
4. Local Control Page 61
5. Synchronize Page 61
6. Loop Indicator Page 61

Use the jog dial to highlight a submenu item, then press the [OK] button to go to the
corresponding parameter edit display.

[Frefe rence mend 1 (=]

@ Oevem
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1. Quantize

Huantize =]
O |

This setting applies to layer 16 (Solo Mode).
When ON the repeat timing of notes played in the Solo Mode is synchronized with playback
timing in the Score Mode (layers 1 — 7).

mRange............ ON, OFF
mDefault ........... ON
mLED Buttons . ... ... No display

2. Push Sensitivity

Push Sensitivita =
1 SE) =T

Sets the long-press time for the LED buttons.
The TENORI-ON recognizes a button press as a "long press" when the button is held for
longer than the specified Push Sensitivity setting.

mRange............ 50 — 500 (milliseconds)
m Default ........... 120 (milliseconds)
mLED Buttons .. ... .. No display

3. Master Tuning

Master Tuninag =]
EECEHT

Master tuning for the internal MIDI tone generator and the user voices.
This parameter has no effect on the user voices (numbers <01/16,> <02/16,> and <03/16>).

mRange............ -100 — +100 (cents)
m Default ........... 0 (cents)
mLED Buttons . ... ... No display
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4. Local Control

Lozal Control =]
O |

Determines whether TENORI-ON performance input (data) controls the internal MIDI tone
generator (ON) or not (OFF).

When set to "OFF" no sound will be output from the TENORI-ON speakers or headphone
jack, but performance data will still be transmitted via the MIDI connector. Also, the LED
buttons will produce no sound when operated if this parameter is set to "OFF."

mRange............ ON. OFF
mDefault ........... ON
mLED Buttons . ... ... No display

5. Synchronize

Sanchronize =]

MASTER

Sets the master or slave status for multiple TENORI-ON units to be synchronized via a MIDI
connection. The "Master" TENORI-ON provides the clock for all "Slave" TENORI-ON units.
©® ATENORI-ON set to the Slave mode will only function properly if correctly connected to the Master TENORI-
ON.

© For synchronized operation, make sure that the Master TENORI-ON is playing back at a tempo that is close to
the tempo at which the performance data for the Slave TENORI-ON was created. The Slave performance
may not be reproduced properly if there is too great a difference between the tempos.

mRange............ MASTER, SLAVE
m Default ........... MASTER
mLED Buttons . ... ... No display

6. Loop Indicator

Loop Indicator =]

Determines whether the loop indicator is visible (ON) or not (OFF) in the Score Mode.
This setting applies to all Score Mode layers (layers 1 — 7).

mRange............ ON, OFF
mDefault ........... ON
mLED Buttons . ... ... Loop indicator
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M File Menu

The File menu provides access to functions that allow you to save data to an SD Memory
Card, load sample files, and more.
The File menu submenu includes the following 6 items.

1. | Song Page 64
2. | All Blocks Page 68
3. | Current Block Page 73
4. | Current Layer Page 78
5. | All Settings Page 83
6. | Samplings Page 88

Use the jog dial to highlight a submenu item, then press the [OK] button to go to the
corresponding parameter edit display.

[File menul =]
urren Dc . O K O CANCEL

Each item in the File menu submenu has a further 3 — 5 functions that you will need to select
from.

After accessing a submenu, use the jog dial to highlight the desired function and then press
the [OK] button.

Function Name

Submenu Name r Sona =
L Operation:
. oK O CANCEL

File Name (

L

Refer to the Display Message List on Page 111 for information about error messages that
may be displayed during SD Memory Card access operations.

©® The TENORI-ON can only display file names consisting of up to 16 ASCII characters, not including the file
extension. 2-byte characters cannot be displayed.

Files saved to an SD Memory Card are saved in a "TENORI-ON" folder that is automatically
created on the card. Up to 1,000 files can be stored in the TENORI-ON folder, or up to 256
files of each file-extension type.

Before using SD Memory Cards with the TENORI-ON, be sure to read “Handling SD™ Memory Cards”
on Page 63.
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Handling SD™ Memory Cards

*SD Memory Card is a registered trademark of the SD Card Association.

This instrument features a built-in SD Memory Card slot. It lets you save original data you've created on the
instrument to a SD Memory Card, and allows you to load data from a card to the instrument. Be sure to
handle SD Memory Cards with care. Follow the important precautions below.

Compatible SD Memory Card types

® SD Memory Cards with a capacity of two gigabytes or
less.
NOTE:

* SD Memory Cards formatted on this device may or
may not be useable as is on other devices.

e This instrument is not compatible with SDIO and
SDHC cards.

Formatting SD Memory Cards

® If you find that you are unable to use new, blank SD
Memory Cards or cards that have been used with
other devices, you may need to format them. For
details on how to format a SD Memory Card, see
Page 107. Keep in mind that all data on the card will
be lost after formatting. Make sure to check
beforehand whether or not the card contains
important data.

NOTE:

* SD Memory Cards formatted on this device may or
may not be useable as is on other devices.

Inserting/removing SD Memory Cards

Inserting SD Memory Cards

® Insert the SD Memory Card with the terminal (gold-
plated) side face down into the card slot, until it clicks
into place.

O
O

OO0
QOQQ)
QOO
aaal

® Do not insert the SD Memory Cards in the wrong
direction.

® Do not insert anything other than a SD Memory Card
in the slot.

Removing SD Memory Cards

® After making sure that the instrument is not
accessing* the SD Memory Card, insert the card until
it clicks into place and release it. When the SD
Memory Card is ejected, pull it out of the drive. If the
card cannot be removed because it is stuck, do not
try to force it, but instead try re-inserting the card
completely into the slot and attempt to eject it again.

* Accessing includes saving, loading, formatting and
deleting. Also, be aware that the instrument will
automatically access the SD Memory Card to check
the media type when it is inserted while the instrument
is turned on.

A Never attempt to remove the SD Memory
Card or turn the power off during
accessing. Doing so can damage the
data on the instrument or card and
possibly damage the SD Memory Card
itself.

About SD Memory Cards

Handle SD Memory Cards with care, and follow
these precautions:

® There are times when static electricity affects SD
Memory Card. Before you touch a SD Memory Card,
touch something metallic such as a door knob and
aluminum sash, to reduce the possibility of static
electricity.

® Be sure to remove the SD Memory Card from the SD
Card slot when it is not in use for a long time.

® Do not expose the SD Memory Card to direct sunlight,
extremely high or low temperatures, or excessive
humidity, dust or liquids.

® Do not place heavy objects on a SD Memory Card or
bend or apply pressure to the card in any way.

® Do not touch the gold-plated terminals of the SD
Memory Card or put any metallic plate onto the
terminals.

® Do not expose the SD Memory Card to magnetic
fields, such as those produced by televisions,
speakers, motors, etc., since magnetic fields can
partially or completely erase data on the SD Memory
Card, rendering it unreadable.

To protect your data (write-protect switch):

® SD Memory Cards are equipped with a write-protect
switch. To prevent accidental erasure of important
data saved in SD Memory Card, slide the write-protect
switch on the device to the "protect" position. When
saving data, make sure that the write-protect switch is
set to the "overwrite" position.

Data Backup

® For maximum data security, Yamaha recommends that
you keep two copies of important data on separate
SD Memory Cards. This gives you a backup if one
card is lost or damaged.
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1. Song

Provides access to song file operations.

'Song'" files are files created by the TENORI-ON song recording function (— Page 109).

In addition to performance data (active notes and settings such as voice, tempo, etc.) for all
layers and blocks, all button and jog dial operations are recorded in real time. A recorded
Song file can then be loaded in into the TENORI-ON and played back, precisely reproducing
the entire performance as it occurred.

The following 3 Song file functions are provided:

Load Song Page 64

Rename Song Page 65

Delete Song Page 67
e Load Song

Loads a Song file that has been saved to an SD Memory Card into the TENORI-ON.

1 Insertthe SD Memory Card containing the file you want to load into the TENORI-ON
card slot.

2 Usethe jog dial and [OK] button to navigate to the Song function menu as follows:
"Main menu" — "File menu" — "Song"

Sona =
Deperation:

3 Usethe jog dial to highlight the "Load" function, then press the [OK] button.

4 Song files on the card will appear as a list on the LCD display (with no file extension).
Use the jog dial to select the file you want to load.
{ ) }
©® Only files that are in song-file format will be displayed.
5  Pressthe [OK] button to load the selected file.
The display shown below will appear while the file is being loaded.
Press the [OK] or [CANCEL] button to cancel the load operation.

Song! =] w
"AEEZE-S0OHG-82 — " The name of the Song file being
loaded.

Loading. .. (RSN J oace
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6 Whenthe Song file has been loaded the display shown below will appear, and playback

will begin.
Press the [OK] button when you want to stop playback.

Sona. =]
HaEZE-SOMG-02
TEHOR I-0OH-M&STER Composer Name
B3B3 21 )

© The composer name that appears on the third line of the display is the registered "Owner Name" for the
TENORI-ON on which the Song file was recorded (— Page 107).

e Rename Song

Allows a new name to be entered for a Song file on an SD Memory Card.

1

Insert the SD Memory Card containing the file you want to rename into the TENORI-ON
card slot.

Use the jog dial and [OK] button to navigate to the Song function menu as follows:
"Main menu" — "File menu" — "Song"

Sona =]
Operation:

Use the jog dial to highlight the "Rename" function, then press the [OK] button.

Song =]
Operation: . Q

Song files on the card will appear as a list on the LCD display (with no file extension).
Use the jog dial to select the file you want to rename.

509 Renme , =]
G:-:éEE—:E;ljlﬁE—éE'
[5]

BaE G SOHE—E 1

© Only files that are in song-file format will be displayed.
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5 Pressthe [OK] button to go to the file name entry display. The name of the currently
selected file will be displayed, and you can enter a new file name as required.

. N
Current Song File Name ( I?EEEEEL‘%EHEEBE@) 1}3 | Input Cursor
ABCDEF GHI JELMHOPRES ,
UMY E-B123456789 <f] ) SetFileName
Available Characters ——————————— Backspace & Delete 1 Character

The Input cursor "B" indicates the current entry point in the file name displayed on the
second line of the LCD. Use the jog dial to highlight the character you want to enter in
the list on the third and fourth lines of the LCD, then press the [OK] button to enter that
character at the current entry point. When a character is entered the cursor moves one
character to the right, ready for the next character. If you want to enter a new character
in the middle of the file name, you will need to delete and re-enter all characters up to
that point.

To delete characters, use the jog dial to highlight the "&" symbol in the lower right corner
of the display and press the [OK] button as many times as necessary.

File names can be up to 16 alphanumeric and hyphen (-) characters in length, not
including the file extension. The file extension will be added automatically.

Imput File Hame =]
[BSBEE—SDHE—EE@%—%A;lgf Input Cursor

ABCHEF GHI KL MHOPRRST

LWVUEY E-B1 223456789 4 .DK QEANCEL
Character Selected for Inputé

I?EEEEELéEHEEEEK@ﬂ Cursor Moves 1 Character

AEE&EFEHMHLMHDF‘EEST After Input

[ Z-E123d56787 4

6 When the file name has been entered as required use the jog dial to highlight the "#"
symbol in the lower right corner of the display and press the [OK] button.
"Executing ..." will appear on the display while the file is being renamed.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
& "Executing..." display is showing.

o If afile with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

Sona:
1-0RIGIMAL-BE1
Al reada Exi 1
Overwrite?

© Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

7/ The display shown in step 3, above, will reappear when the operation has finished.
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e Delete Song

Deletes a specified Song from an SD Memory Card.

1

Insert the SD Memory Card containing the file you want to delete into the TENORI-ON
card slot.

Use the jog dial and [OK] button to navigate to the Song function menu as follows:
"Main menu" — "File menu" — "Song"

Sons =
Oeeration:

Use the jog dial to highlight the "Delete" function, then press the [OK] button.

Song =]
Operation: [KSNEERES . Q

Song files on the card will appear as a list on the LCD display (with no file extension).
Use the jog dial to select the file you want to delete.
) }

|

© Only files that are in song-file format will be displayed.

Press the [OK] button to delete the selected file.

A confirmation display like the one shown below will appear.

Press the [OK] button if it's OK to delete the file. Press the [CANCEL] button (or use the
jog dial to select "CANCEL" on the LCD and then press the [OK] button) to cancel the
operation and leave the file unaltered.

[elete =]
{ "EZRZE-SOHG-82 " }
| Ok |

If you press the [OK] button to execute the delete operation, "Executing ..." will appear
on the display while the file is being deleted.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Executing..." display is showing.

The display shown in step 3, above, will reappear when the operation has finished.
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2. All Blocks

Provides access to All Blocks file operations.

"All Blocks" files include active notes and settings such as voice, tempo, etc., for all layers
and blocks.

The following 4 All Blocks file functions are provided:

Load All Blocks Page 68
Save All Blocks Page 69
Rename All Blocks Page 70
Delete All Blocks Page 71

e Load All Blocks
Loads an All Blocks file that has been saved to an SD Memory Card into the TENORI-ON.

1

Insert the SD Memory Card containing the file you want to load into the TENORI-ON
card slot.

Use the jog dial and [OK] button to navigate to the All Blocks function menu as follows:
"Main menu" — "File menu" — "All Blocks"

&1 Blocks =
Oeeration:

Use the jog dial to highlight the "Load" function, then press the [OK] button.

All Blocks files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to load.

|

© Only files that are in All Blocks format will be displayed.

Press the [OK] button to load the selected file.
The display shown below will appear while the file is being loaded.
Press the [OK] or [CANCEL] button to cancel the load operation.

Elocks: &=
"AZEZE-BLOCKS-AZ2 ¢ J The name of the All Blocks file being

loaded.
Loadina. .. [MHE(eaE
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6 When the All Blocks file has been loaded the display shown in step 2, above, will

appear, and playback of the All Blocks file will begin.
Press the [OK] button in the status display when you want to stop playback.

e Save All Blocks

Saves an All Blocks file containing all active notes and settings such as voice, tempo, etc.,
for all layers and blocks to an SD Memory Card.

1

Insert an SD Memory Card that has sufficient free space for the file to be saved into the
TENORI-ON card slot.

Use the jog dial and [OK] button to navigate to the All Blocks function menu as follows:
"Main menu" — "File menu" — "All Blocks"

&1 Blocks =
Oeeration:

Use the jog dial to highlight the "Save" function, then press the [OK] button.

@ O

&l Blocks =]
Operation: EEUCEE

The file name entry display will appear. A default file name will be provided, which you
can either use as-is or replace with a name of your own.
File name entry procedure is described in the Rename Song section on Page 65.

/

Current All Blocks File Name ( I?EEEEELéEDEEEEE'—@iﬁ | Input Cursor
AECDEF GH [nJKLMHDF‘E!R(S_ﬁ ,
UMY Z-B1 23456789 ) SetFile Name
Available Characters ——————— [ Backspace & Delete 1 Character

When the file name has been entered as required use the jog dial to highlight the "4#"
symbol in the lower right corner of the display and press the [OK] button.

The file name will be entered and the save function will be executed.

A display like the one shown below will appear while the All Blocks file is being saved.
You can cancel the operation by pressing the [OK] or [CANCEL] button.

Elocks: =
"1-BLOCKS18Z28-81 * The name of the All Blocks file being
d.

Savina. .. [EEEEN J e

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Saving..." display is showing.
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o If afile with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

Blocks
1—BLDCKE1BQB B1
4l reads Exi
Overwrite’

© Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

5 The display shown in step 3, above, will reappear when the operation has finished.

o Rename All Blocks

Allows a new name to be entered for an All Blocks file on an SD Memory Card.

1 Insertthe SD Memory Card containing the file you want to rename into the TENORI-ON
card slot.

2 Usethe jog dial and [OK] button to navigate to the All Blocks function menu as follows:
"Main menu" — "File menu" — "All Blocks"

A1 Blocks =
Oeeration:

3 Usethe jog dial to highlight the "Rename" function, then press the [OK] button.

&l Bloczks =]

Operation:
.DK OCANCE\_

4 All Blocks files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to rename.

El c-clcs Rename =]

© Only files that are in All Blocks format will be displayed.
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5 Pressthe [OK] button to go to the file name entry display. The name of the currently
selected All Blocks file will be displayed, and you can enter a new file name as required.
File name entry procedure is described in the Rename Song section on Page 65.

© File names can be up to 16 characters in length. The file extension will be added automatically.

(Inegt File Hame @) i
Current All Blocks File Name ﬁéEDEFEH [UKLMNDP&RS .
LYY 2 -81 2345578 |- SetFile Name
Available Characters ————————————— \; Backspace & Delete 1 Character

6 When the file name has been entered as required use the jog dial to highlight the "¢"
symbol in the lower right corner of the display and press the [OK] button.
"Executing ..." will appear on the display while the file is being renamed.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Executing..." display is showing.

© If a file with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

EBlocks =]
"1 BLDEKS1BB1 B1 "
Al ready Exi
Overwri e’

©® Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

7 The display shown in step 3, above, will reappear when the operation has finished.

o Delete All Blocks

Deletes a specified All Blocks file from an SD Memory Card.

1 Insertthe SD Memory Card containing the file you want to delete into the TENORI-ON
card slot.

2 Usethe jog dial and [OK] button to navigate to the All Blocks function menu as follows:
"Main menu" — "File menu" — "All Blocks"

411 Blocks =
Oeeration:

3 Usethe jog dial to highlight the "Delete" function, then press the [OK] button.

all Blocks =]
Operation: KSIEERES

@- Oevem
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All Blocks files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to delete.

|

© Only files that are in All Blocks format will be displayed.

Press the [OK] button to delete the selected file.

A confirmation display like the one shown below will appear.

Press the [OK] button if it's OK to delete the file. Press the [CANCEL] button (or use the
jog dial to select "CANCEL" on the LCD and then press the [OK] button) to cancel the
operation and leave the file unaltered.

If you press the [OK] button to execute the delete operation, "Executing ..." will appear
on the display while the file is being deleted.

Delete =]
"BEZ8ZE-BLOCKS-B82 "¢

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
& "Executing..." display is showing.

The display shown in step 3, above, will reappear when the operation has finished.
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3. Current Block

Provides access to Current Block file operations.

"Current Block" files include active notes and settings such as voice, tempo, etc., for all
layers in the current block.

The following 4 Current Block file functions are provided:

Load Current Block Page 73
Save Current Block Page 74
Rename Current Block Page 75
Delete Current Block Page 77

e Load Current Block

Loads a Current Block file that has been saved to an SD Memory Card into the TENORI-ON.

When a block is loaded the layer settings for all other blocks will also be overwritten by the loaded
data.

1 Make sure the block that you want to load the data into is selected on the TENORI-ON
(Function Button [R5]: Page 34).

2 Insert the SD Memory Card containing the file you want to load into the TENORI-ON
card slot.

3 Usethe jog dial and [OK] button to navigate to the Current Block function menu as
follows:
"Main menu" — "File menu" — "Current Block"

Current Block Number

Elock[@i]: =
Operation:

4 Usethe jog dial to highlight the "Load" function, then press the [OK] button.

5 Current Block files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to load.

B}

® Only files that are in Current Block format will be displayed.

Load
l p—

__h'. S
[T e
OCE—H

A, A

HAHZE-EL
1.5k =

{BIG[EH:

6 Press the [OK] button to load the selected file.
The display shown below will appear while the file is being loaded.
Press the [OK] or [CANCEL] button to cancel the load operation.
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Current Block Number
Elock[@1]: =
"EAZRZE-BLOCK—-BAZ —"——— The name of the Current Block file
being loaded.
Loadina. .. [EEiE[EN

When the Current Block file has been loaded the display shown in step 3, above, will
appear, and playback of the Current Block file will begin.
Press the [OK] button in the status display when you want to stop playback.

@ Save Current Block

Saves a Current Block file containing all active notes and settings such as voice, tempo, etc.,
for all layers in the current block to an SD Memory Card.

1

Insert an SD Memory Card that has sufficient free space for the file to be saved into the
TENORI-ON card slot.

Use the jog dial and [OK] button to navigate to the Current Block function menu as
follows:
"Main menu" — "File menu" — "Current Block"

Block[@ll: =]
Oreration:

Use the jog dial to highlight the "Save" function, then press the [OK] button.

Operation: =EN

{BIDGI{[BHZ

E}
. oK O CANCEL

The file name entry display will appear. A default file name will be provided, which you
can either use as-is or replace with a name of your own.
File name entry procedure is described in the Rename Song section on Page 65.

© File names can be up to 16 characters in length. The file extension will be added automatically.

c , (Inl:hut File Hame =
urrent Block File Name r BEBEE—BLDCK—B@%f Input Cursor
AECDEFGH [nJKLMHDF‘ER(S_ﬁ
UMWY E-B123456789 <l ) SetFile Name
Available Characters —————————————— I Backspace & Delete 1 Character
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5 When the file name has been entered as required use the jog dial to highlight the "¢"
symbol in the lower right corner of the display and press the [OK] button.
The file name will be entered and the save function will be executed.
A display like the one shown below will appear while the Current Block file is being
saved.
You can cancel the operation by pressing the [OK] or [CANCEL] button.

Elock[811: =
"1-BLOCK1@2B-81 * J The Current Block file being saved.

Savina. .. [MEHIN

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
& "Saving..." display is showing.

o If afile with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

Elock[E]]: =]
{ "1—BLDDK1EIQB—EI1I " }

4l ready Exi
Overwri e’

© Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

6 The display shown in step 3, above, will reappear when the operation has finished.

e Rename Current Block

Allows a new name to be entered for a Current Block file on an SD Memory Card.

1 Insertthe SD Memory Card containing the file you want to rename into the TENORI-ON
card slot.

2 Usethe jog dial and [OK] button to navigate to the Current Block function menu as
follows:
"Main menu" — "File menu" — "Current Block"

Elockial]l: =]
Oeeration:

3 Usethe jog dial to highlight the "Rename" function, then press the [OK] button.

Block[@l]: =]
Operation:

@- Oeovem
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4 Current Block files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to rename.

BI-:u:k[EH Lna =]

© Only files that are in Current Block format will be displayed.

Press the [OK] button to go to the file name entry display. The name of the currently
selected Current Block file will be displayed, and you can enter a new file name as
required. File name entry procedure is described in the Rename Song section on
Page 65.

© File names can be up to 16 characters in length. The file extension will be added automatically.

c . fInnut File Hame =
urrent Block File Name . BEBEE—BLDCK—B@if Input Cursor
AECLDEF GH [dI{LMHDPER(S_a
LYY 2-81 23455739 ) SetFile Name
Available Characters———————— Backspace & Delete 1 Character

5 When the file name has been entered as required use the jog dial to highlight the "¢"
symbol in the lower right corner of the display and press the [OK] button.
"Executing ..." will appear on the display while the file is being renamed.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Executing..." display is showing.

o If afile with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

Elockl@]ll: =]
1 —-ELOCE 18681 Bi

4l reads Exi
Overwrite?

©® Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

6 The display shown in step 3, above, will reappear when the operation has finished.

TENORI-ON Manual 76



Parameter Settings

Setting Parameters with the Jog Dial M File Menu

o Delete Current Block

Deletes a specified Current Block file from an SD Memory Card.

1

Insert the SD Memory Card containing the file you want to delete into the TENORI-ON
card slot.

Use the jog dial and [OK] button to navigate to the Current Block function menu as
follows:
"Main menu" — "File menu" — "Current Block"

Blockl@ll: =]
Operation:

Use the jog dial to highlight the "Delete" function, then press the [OK] button.

{BIDGHBH:

i }
Operation: KEIERES
. O K Q CANCEL

Current Block files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to delete.

©® Only files that are in Current Block format will be displayed.

Press the [OK] button to delete the selected file.

A confirmation display like the one shown below will appear.

Press the [OK] button if it's OK to delete the file. Press the [CANCEL] button (or use the
jog dial to select "CANCEL" on the LCD and then press the [OK] button) to cancel the
operation and leave the file unaltered.

Delete =]
{ "EZRZE-BLOCK-BZ " }
| Ok |

If you press the [OK] button to execute the delete operation, "Executing ..." will appear
on the display while the file is being deleted.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Executing..." display is showing.

The display shown in step 3, above, will reappear when the operation has finished.
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4. Current Layer

Provides access to Current Layer file operations.

"Current Layer" files include active notes and settings such as voice, tempo, etc., for the
current layer in the current block.

The following 4 Current Layer file functions are provided:

Load Current Layer Page 78
Save Current Layer Page 79
Rename Current Layer Page 80
Delete Current Layer Page 82

e Load Current Layer

Loads a Current Layer file that has been saved to an SD Memory Card into the TENORI-ON.
A When a layer is loaded the layer settings for all other blocks will also be overwritten by the loaded data.

1 Make sure the layer that you want to load the data into is selected on the TENORI-ON
(Function Button [R1] Layer Number: Page 30).

2 Insert the SD Memory Card containing the file you want to load into the TENORI-ON
card slot.

3 Usethe jog dial and [OK] button to navigate to the Current Layer function menu as
follows:
"Main menu" — "File menu" — "Current Layer"

Current Layer Number

Lawer[@l]l: =
Oeeration:

4 Usethe jog dial to highlight the "Load" function, then press the [OK] button.

5 current Layer files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to load.

|

© Only files that are in Current Layer format will be displayed.
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Press the [OK] button to load the selected file.
The display shown below will appear while the file is being loaded.
Press the [OK] or [CANCEL] button to cancel the load operation.

Current Layer Number

Lawer[@1
"EZEZE-
n

Loadina. .. [HEWIN

1: =
LAYER-B2—"———— The name of the Current Layer file
J being loaded.

When the Current Layer file has been loaded the display shown in step 3, above, will
appear, and playback of the Current Layer file will begin.
Press the [OK] button in the status display when you want to stop playback.

e Save Current Layer

Saves a Current Layer file containing all active notes and settings such as voice, tempo, etc.,
for the current layer in the current block to an SD Memory Card.

1

Insert an SD Memory Card that has sufficient free space for the file to be saved into the
TENORI-ON card slot.

Use the jog dial and [OK] button to navigate to the Current Layer function menu as
follows:
"Main menu" — "File menu" — "Current Layer"

Laweri@l]: =]
Oeeration:

Use the jog dial to highlight the "Save" function, then press the [OK] button.

{Laaer[m 1:

=]
Operation: EEUEEE } @« () emem

The file name entry display will appear. A default file name will be provided, which you
can either use as-is or replace with a name of your own.
File name entry procedure is described in the Rename Song section on Page 65.

© File names can be up to 16 characters in length. The file extension will be added automatically.

Current Layer File Name ( I?E%EEELII_EVEETEE@]Ef Input Cursor
AECDEFGH [dKLMNDPER(S_ﬁ
UNMIENE-B123456789 <l ) setFile Name
Available Characters —————————————— I Backspace & Delete 1 Character
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5 When the file name has been entered as required use the jog dial to highlight the "¢"
symbol in the lower right corner of the display and press the [OK] button.
The file name will be entered and the save function will be executed.
A display like the one shown below will appear while the Current Layer file is being
saved.
You can cancel the operation by pressing the [OK] or [CANCEL] button.

\

J The Current Layer file being saved.

@11:
YER18Z20-81
na. .. [eEIEW

w

Lager(
1-L&

r
L
Wi

Sa

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Saving..." display is showing.

o If afile with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

Lager[@]]:
1-LAYER1BZ28-61
Al ready Exi 1
Overwrite?

©® Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

6 The display shown in step 3, above, will reappear when the operation has finished.

e Rename Current Layer

Allows a new name to be entered for a Current Layer file on an SD Memory Card.

1 Insertthe SD Memory Card containing the file you want to rename into the TENORI-ON
card slot.

2 Usethe jog dial and [OK] button to navigate to the Current Layer function menu as
follows:
"Main menu" — "File menu" — "Current Layer"

Lager[@l]: =]
Operation:

3 Usethe jog dial to highlight the "Rename" function, then press the [OK] button.

Lager[@E]]: =]
Operation:

. oK O CANCEL
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4 current Layer files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to rename.

© Only files that are in Current Layer format will be displayed.

Press the [OK] button to go to the file name entry display. The name of the currently
selected Current Layer file will be displayed, and you can enter a new file name as
required. File name entry procedure is described in the Rename Song section on
Page 65.

© File names can be up to 16 characters in length. The file extension will be added automatically.

. . ((Ineut File Hame _ {51

urrent Layer File Name . BEBEE—L#VER—B@]if Input Cursor
AECDEFGHI JEL MHOPRES |
UNMIENZ-B123406789 ] ) SetFile Name

Available Characters—————————— Backspace & Delete 1 Character

5 When the file name has been entered as required use the jog dial to highlight the "¢"
symbol in the lower right corner of the display and press the [OK] button.
"Executing ..." will appear on the display while the file is being renamed.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Executing..." display is showing.

o If afile with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

0=

ade
1_
&l
(e

©® Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

6 The display shown in step 3, above, will reappear when the operation has finished.
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e Delete Current Layer

Deletes a specified Current Layer file from an SD Memory Card.

1

Insert the SD Memory Card containing the file you want to delete into the TENORI-ON
card slot.

Use the jog dial and [OK] button to navigate to the Current Layer function menu as

follows:
"Main menu" — "File menu" — "Current Layer"

Lagwer[@ll: =]
Operation:

Use the jog dial to highlight the "Delete" function, then press the [OK] button.

{Lauer[51]:

i }
Operation: KEIERES
. O K Q CANCEL

Current Layer files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to delete.

te =]
Bz
[5]]

©® Only files that are in Current Layer format will be displayed.

DEZE LAY
el T

F=
R

Lauer[m 1. D
E
E

Press the [OK] button to delete the selected file.

A confirmation display like the one shown below will appear.

Press the [OK] button if it's OK to delete the file. Press the [CANCEL] button (or use the
jog dial to select "CANCEL" on the LCD and then press the [OK] button) to cancel the
operation and leave the file unaltered.

Delete =]
{ "EZRZE-LAYER-BZ " }
| Ok |

If you press the [OK] button to execute the delete operation, "Executing ..." will appear
on the display while the file is being deleted.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Executing..." display is showing.

The display shown in step 3, above, will reappear when the operation has finished.
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5. All Settings

Provides access to All Settings file operations.

"All Settings" files include all settings such as voice, tempo, etc., for all layers and blocks.
Active notes are not included.

The following 4 All Settings file functions are provided:

Load All Settings Page 83
Save All Settings Page 84
Rename All Settings Page 85
Delete All Settings Page 86

e Load All Settings
Loads an All Settings file that has been saved to an SD Memory Card into the TENORI-ON.

1 Insertthe SD Memory Card containing the file you want to load into the TENORI-ON
card slot.

2 Usethe jog dial and [OK] button to navigate to the All Settings function menu as follows:
"Main menu" — "File menu" — "All Settings"

Al Settings: =]
Oeeration:

3 Usethe jog dial to highlight the "Load" function, then press the [OK] button.

4 Al Settings files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to load.

i }
5  Pressthe [OK] button to load the selected file.
The display shown below will appear while the file is being loaded.
Press the [OK] or [CANCEL] button to cancel the load operation.

ﬂﬁetnas: Lud

A A
HEE-SET-H
] ]

A
[50E]
1. -

© Only files that are in All Settings format will be displayed.

Settings: = )
"HIEZE-SET-82 t The name of the All Settings file
i N being loaded.
Loadina. .. [EES[HSN
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6 When the All Settings file has been loaded the display shown in step 2, above, will
appear, and playback of the existing active notes will begin using the All Settings data
just loaded.

Press the [OK] button in the status display when you want to stop playback.

e Save All Settings

Saves an All Settings file containing all settings such as voice, tempo, etc., for all layers and
blocks to an SD Memory Card. Active notes are not included.

1 InsertanSD Memory Card that has sufficient free space for the file to be saved into the
TENORI-ON card slot.

2 Usethe jog dial and [OK] button to navigate to the All Settings function menu as follows:
"Main menu" — "File menu" — "All Settings"

all Settinas: =]
Operation:

3 Usethe jog dial to highlight the "Save" function, then press the [OK] button.

&l Settinas:
Operation: EEUCEE

E}
. oK Q CANCEL

4 The file name entry display will appear. A default file name will be provided, which you
can either use as-is or replace with a name of your own.
File name entry procedure is described in the Rename Song section on Page 65.

© File names can be up to 16 characters in length. The file extension will be added automatically.

Current All Settings File Name ( I?EEEEEL‘%ETHSEii]Ef Input Cursor
AECDEF GH [nJKLMHDF‘E!R(S_ﬁ
UNIENE-B123406789 ] ) SetFile Name
Available Characters —————— Backspace & Delete 1 Character

5 When the file name has been entered as required use the jog dial to highlight the "¢"
symbol in the lower right corner of the display and press the [OK] button.
The file name will be entered and the save function will be executed.
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A display like the one shown below will appear while the All Settings file is being saved.
You can cancel the operation by pressing the [OK] or [CANCEL] button.

Settinas: =
"1-SET1828-a1 e J The All Settings file being saved.

Savina. .. [MEHIN

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Saving..." display is showing.

o If afile with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

Settinas:
1-SET1@2E-61
A reada Exi
Cwerwri te’

© Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

6 The display shown in step 3, above, will reappear when the operation has finished.

e Rename All Settings

Allows a new name to be entered for an All Settings file on an SD Memory Card.

1 Insertthe SD Memory Card containing the file you want to rename into the TENORI-ON
card slot.

2 Usethe jog dial and [OK] button to navigate to the All Settings function menu as follows:
"Main menu" — "File menu" — "All Settings"

Al Settinas: =]
Operation:

3 Usethe jog dial to highlight the "Rename" function, then press the [OK] button.

Al Settinas: =]
Operation:

. oK O CANCEL

4 A Settings files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to rename.

® Only files that are in All Settings format will be displayed.
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5 Pressthe [OK] button to go to the file name entry display. The name of the currently
selected All Settings file will be displayed, and you can enter a new file name as
required. File name entry procedure is described in the Rename Song section on
Page 65.

© File names can be up to 16 characters in length. The file extension will be added automatically.

. - (Ineut File Hame @31 )
urrent All Settings File Name . BEBEE—?ET—BE@)i]f Input Cursor
AECLDEF GH [nJKLMHDF'E!R(S_ﬁ
UNMIENE-B123406739 ] ) SetFile Name
Available Characters—————————— Backspace & Delete 1 Character

6 When the file name has been entered as required use the jog dial to highlight the "4"
symbol in the lower right corner of the display and press the [OK] button.
"Executing ..." will appear on the display while the file is being renamed.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Executing..." display is showing.

o If afile with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

Settinas:
1-SET1@18-81

A reada Exi 1

Dwerwr i te’

© Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

7 The display shown in step 3, above, will reappear when the operation has finished.

e Delete All Settings

Deletes a specified All Settings file from an SD Memory Card.

1 Insertthe SD Memory Card containing the file you want to delete into the TENORI-ON
card slot.

2 Usethe jog dial and [OK] button to navigate to the All Settings function menu as follows:
"Main menu" — "File menu" — "All Settings"

&l Settinas: =]
Operation:

3 Usethe jog dial to highlight the "Delete" function, then press the [OK] button.

&l Settinas: =]
Operation: YRS
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4 A Settings files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to delete.

{ EI}
© Only files that are in All Settings format will be displayed.
5  Pressthe [OK] button to delete the selected file.
A confirmation display like the one shown below will appear.
Press the [OK] button if it's OK to delete the file. Press the [CANCEL] button (or use the
jog dial to select "CANCEL" on the LCD and then press the [OK] button) to cancel the
operation and leave the file unaltered.

[elete =]
"EIRZE-SET-G02 "
| Ok |

If you press the [OK] button to execute the delete operation, "Executing ..." will appear
on the display while the file is being deleted.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
& "Executing..." display is showing.

6 The display shown in step 3, above, will reappear when the operation has finished.
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6. Samplings

Provides access to Samplings file operations.

The TENORI-ON provides three user voices: <01/16,> <02/16,> and <03/16.> Audio
samples can be loaded into the TENORI-ON and played via these voices.

Audio samples can be converted to the sample format used by the TENORI-ON (.tnw file
extension) using the TENORI-ON User Voice Manager software provided on the supplied
CD-ROM. This menu provides access to a number of functions that can be used to manage
"tnw" files.

The following 5 Samplings file functions are provided:

Load Samplings Page 93
Save Samplings Page 94
Rename Samplings Page 95
Delete Samplings Page 97
Samplings Info Page 98
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m Creating User Voices (Sampling Files)

Audio files that have been recorded using a computer or downloaded from the Internet
must be converted to the TENORI-ON user voice file format ("sampling” file format with a
"tnw" file name extension) before they can be loaded into the TENORI-ON user voice
numbers and played.

The TENORI-ON User Voice Manager software provided on the supplied CD-ROM can be
used to convert audio files to the appropriate format and assign them to the TENORI-ON
LED buttons. Sampling files thus created can then be transferred to the TENORI-ON using
an SD Memory Card.

Save
Sampling File D SD Memory Card
(Single File) >
Assign ) ~14 Card Slot
Sound Files — .

16 Files - Loaded into the
( ) internal TENORI-

> Conversion ON user memory.

— |
TENORI-ON User Voice Manager TENORI-ON

1 Prepare the audio files.
Samples can be extracted from commercially obtainable sample CDs, downloaded
from the Internet, or recorded using your own recording equipment or computer. The
sample files must be in either WAV or AIFF format.
The supported file formats are as follows:
22.05 kHz, 24 kHz, 44.1 kHz, or 48 kHz sampling rate; 8 or 16 bits; stereo or mono.

® Mono files will be converted to stereo files with the same data in the L and R channels.

Up to 16 samples can be assigned to each user voice (one of each of 16 LED
buttons). For a single instrument voice, for example, those samples can be at 16
different pitches. The audio files assigned to a TENORI-ON user voice can be used
in two different ways:

©® Sound effects, drum or percussion sounds, or other types of one-shot samples can be individually
played by the LED buttons to which they are assigned.

© Audio files of the same instrument at different pitches can be assigned to the LED buttons in scale
sequence so they can be played in the same way as the internal MIDI tone generator voices.

It is necessary to prepare the appropriate type of audio files according to way they
are to be used.
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2 Launch the TENORI-ON User Voice Manager software.

Use the TENORI-ON User Voice Manager software included on the supplied CD-

ROM to convert your files to the TENORI-ON format and assign them to the

appropriate LED buttons.

2-1 Install the TENORI-ON User Voice Manager on your computer following the
procedure outlined in the separate "TENORI-ON User Voice Manager
Installation Guide" document.

2-2 Double click the "TNR_UserVoiceMgr.exe" or "TNR_UserVoiceMgr.app" file on
your computer to launch the software.

00 & oe\
\
f ““““““ Jﬂ% @ [LOAD] Button
() mysoundoa ® @)
@i Qo © File Name
Qo © [EXIT] Button
T Qo @ [DELETE] Button
@ Qo ® [PLAY] Button
Q9 @ [MAKE USER VOICE] Button
Q)
©) Q)
Q- Q9
()
@9
[©) Qo
Q@9
Q@9
@ Q)
@) Q)

TENDRI on
\A USERVOK)E MANAGER 6

A graphic representation of the TENORI-ON and LED button arrangement in the Score
Mode will appear on the display. [LOAD] buttons 1 through 16 on the display correspond
to the equivalent TENORI-ON LED button positions.
©® When shipped from the factory the vertical-axis of the LED button matrix is assigned to a scale
corresponding to the white keys on a piano, as show in the illustration below. If you assign audio files with

pitches corresponding to the default pitches of the buttons, your user voice can be played in the same
way as the internal voices.

Higher D — (@ (rysovnens DO®
C — (@(yzounaoa R®
B — (@ (zoundoe ®®
A — (@ (mysoundoi @
AR O s O®
Fo— @ (peoatiareatin R®
5 B ]

D —_— @ B
Scale c | = O®
B — @ DR®
— @® PG
G — Z DE®©
Fo— @(- R®
E — @ R®
D — 0z ®®
Lower C —( © <2 D[]T)
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Load the audio files.

A dialog window that allows you to select and load an audio file into the TENORI-ON
User Voice Manager will appear when you click one of the [LOAD] buttons.

Select the audio file you want to load and assign to the corresponding button. The
first 0.97 seconds of the selected WAVE or AIFF file will be used. The names of the
assigned audio files will appear to the right of the corresponding [LOAD] buttons
(without the file extension).

Look in: | £ wave ~| & ® ek B
@lmysondatmay  @lspecial_sffect_Cowav  @]vaicel_D2.war
&) mysoundnz.way &) specal_effect_D.wav  &]voicel_E2.wav
| rysoundns.waw &special_effect_Ewav  ©]voice0l_F2.way
(&l mysoundadwaw Elvoicent_A2.wav @]voiced!_G2.wav

(&) special_sffect_awav  EJvoicen]_BZ.wav
(@lspecial_effect Bavav  @lvoicel_Czomav

File name: | Open |
Files of type: ANl Audia Files [ wav." aif i) | Cancel

Click a [PLAY] button to play the corresponding audio file.
Click a [DELETE] button to delete (cancel assignment of) the corresponding audio
file.

the assignments are repeated in 16-note groups.

LED buttons to which no audio file is assigned will produce no sound when pressed.

Save in TENORI-ON "Sampling" format.

When the audio files have been assigned as required, convert the entire set (all 16
files) to a single TENORI-ON format user voice file, and save the user voice file to an
SD Memory Card.

©® Use an SD Memory Card with a capacity of 2 gigabytes or less that has been properly formatted
using the TENORI-ON formatting function (— Page 106: [System menu] — [SD Format]).

Click the [MAKE USER VOICE] button.

The file save dialog window will appear. Specify the location you want to save the file
to (the SD Memory Card) and the file name if necessary. A default file name
consisting of the month and day (e.g. "0901") plus a single character indicating the
hour (0...9, A...N), plus four digits indicating the minute and second (e.g. "3620"),
plus "-VOICE", plus the file extension (.tnw) will be automatically generated. You can
edit the default file name as required, using a maximum of 16 characters. Only
capital alphabetic characters and the hyphen ("-") can be used in file names.

Wolume

Al
KF (D) a
2000E (E) Bl
Backup (F) >
FileName
| 030513526-VOICE
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5  Clickthe [EXIT] button to quit the software.

6 Insert the SD Memory Card to which the file was saved in step 4, above, into the
TENORI-ON card slot.

7 Load the file from the SD Memory Card into a user memory. Refer to "Load
Samplings" on Page 93 for details.
User voice setup is now complete.

8 Play the user voice.

You can now select the user voice by pressing the corresponding LED button while
holding the [L1] button, in the same way as you select the internal voices.

0000000000000

—— USER3<03/16>

2O 000 '@

© Octave, transpose, and scale settings do not affect the user voices.
© User voices are retained in memory even when the TENORI-ON is turned off.

© Inorder to play a song that uses a user voice on a different TENORI-ON, the user voice file must
first be loaded into the TENORI-ON on which the song is to be played (— "Save Samplings" on
Page 94, and "Load Samplings" on Page 93).
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e Load Samplings

Loads a Samplings file that has been saved to an SD Memory Card into the TENORI-ON.

1

Insert the SD Memory Card containing the file you want to load into the TENORI-ON
card slot.

Use the jog dial and [OK] button to navigate to the Samplings function menu as follows:
"Main menu" — "File menu" — "Samplings"

Samel inas: =]
Oeeration:

Use the jog dial to highlight the "Load" function, then press the [OK] button.
A display that allows you to specify the user memory to which the loaded sample file
will be saved will appear. Use the jog dial to select the desired user memory, then press
the [OK] button.

© Inthis display "User1," "User2," and "User3" correspond to user memory numbers <01/16,> <02/16,>

and <03/16.> The bottom line on the LCD displays the name of the sample file currently loaded in that
user memory. If the user memory is empty, "-------- " will be displayed.

t.= Userfl

Samel ings: Load =]
[est.
[1-SaMFLE

Samplings files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to load.

|

© Only files that are in "tnw" format will be displayed.

Press the [OK] button to load the selected file.
The display shown below will appear while the file is being loaded.
Press the [OK] or [CANCEL] button to cancel the load operation.

Same |l inas: EIW
"SaMPLEEY B8 -81 " The name of the Samplings file being
loaded.
Loading. .. ([EGESN J e

© Sampling file load operations may take a few minutes to complete.

When the Samplings file has been loaded the display shown in step 2, above, will
appear.
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e Save Samplings

Saves a Samplings file currently loaded in a user memory to an SD Memory Card in ".tnw"
format.

1 InsertanSD Memory Card that has sufficient free space for the file to be saved into the
TENORI-ON card slot.

2 Usethe jog dial and [OK] button to navigate to the Samplings function menu as follows:
"Main menu" — "File menu" — "Samplings"

Samel inas: =]
Operation:

3 Usethe jog dial to highlight the "Save" function, then press the [OK] button.

Samel inas: =]

Oreration: EEVCEE
.DK QCANCEL

4 A display that allows you to specify the user memory containing the sample to be saved
will appear. Use the jog dial to select the desired user memory (1 — 3), then press the
[OK] button.

© Inthis display "User1," "User2," and "User3" correspond to user memory numbers <01/16,> <02/16,>

and <03/16.> The bottom line on the LCD displays the name of the sample file currently loaded in that
user memory. If the user memory is empty, "-------- " will be displayed.

Samel ings: Sawve =]

Sour.= Userfl
[1-SaMFLE

5 The file name entry display will appear. A current file name will be displayed, which you
can either use as-is or replace with a different name.
File name entry procedure is described in the Rename Song section on Page 65.

© File names can be up to 16 characters in length. The file extension will be added automatically.

N N
Current User Voice File Name ( I??Eéﬁﬁh{é Name ‘}EI l__ Input Cursor
ABCLEFGHIJELMHOPGERS
UNMIENZ-B123456739 ] ) Set File Name
Available Characters———————— L Backspace & Delete 1 Character
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6 When the file name has been entered as required use the jog dial to highlight the "¢"
symbol in the lower right corner of the display and press the [OK] button.
The file name will be entered and the save function will be executed.
A display like the one shown below will appear while the All Settings file is being saved.
You can cancel the operation by pressing the [OK] or [CANCEL] button.

Samelin =] w
SﬁMPLEBT‘I |za-a1 * J The Samplings file being saved.

Savina. .. [HEHIN

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Saving..." display is showing.

© Sampling file save operations may take a few minutes to complete.

o If afile with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

Samelina
SAMPLEET1EEE E1

4l reads Exi

Overwrite’

© Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

7 The display shown in step 3, above, will reappear when the operation has finished.

e Rename Samplings

Allows a new name to be entered for a Samplings file on an SD Memory Card.

1 Insertthe SD Memory Card containing the file you want to rename into the TENORI-ON
card slot.

2 Usethe jog dial and [OK] button to navigate to the Samplings function menu as follows:
"Main menu" — "File menu" — "Samplings"

Samel inas: =]

Operation:

3 Usethe jog dial to highlight the "Rename" function, then press the [OK] button.

Samel inas: =]

Operation:
.DK OCANCE\_
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4 Samplings files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to rename.

© Only files that are in ".tnw" format will be displayed.

Press the [OK] button to go to the file name entry display. The name of the currently
selected Samplings file will be displayed, and you can enter a new file name as
required. File name entry procedure is described in the Rename Song section on
Page 65.

© File names can be up to 16 characters in length. The file extension will be added automatically.

Current Samplings File Name ( I?E'ﬁlﬁptéé$1 ESTEE‘I@]if Input Cursor
AECDEFGHI JEL MHOPRE (_ﬁ
UNMIENZ-B123406789 ] ) SetFile Name
Available Characters———————— Backspace & Delete 1 Character

5 When the file name has been entered as required use the jog dial to highlight the "¢"
symbol in the lower right corner of the display and press the [OK] button.
"Executing ..." will appear on the display while the file is being renamed.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Executing..." display is showing.

o If afile with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

Sa

elin =]
AMPLEBT1EB1 EE "
| reada Exi

am
s
A
Overwrite?

©® Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

6 The display shown in step 3, above, will reappear when the operation has finished.
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e Delete Samplings

Deletes a specified Samplings file from an SD Memory Card.

1

Insert the SD Memory Card containing the file you want to delete into the TENORI-ON
card slot.

Use the jog dial and [OK] button to navigate to the Samplings function menu as follows:
"Main menu" — "File menu" — "Samplings"

Samel inas: =]
Oeeration:

Use the jog dial to highlight the "Delete" function, then press the [OK] button.

ESampl inas:

i }
Operation: KRS
. oK O CANCEL

Samplings files on the card will appear as a list on the LCD display (with no file
extension). Use the jog dial to select the file you want to delete.

|

©® Only files that are in ".tnw" format will be displayed.

Press the [OK] button to delete the selected file.

A confirmation display like the one shown below will appear.

Press the [OK] button if it's OK to delete the file. Press the [CANCEL] button (or use the
jog dial to select "CANCEL" on the LCD and then press the [OK] button) to cancel the
operation and leave the file unaltered.

Delete =]
"SaMPLES? 1881 -81 ¢
[ OK |

If you press the [OK] button to execute the delete operation, "Executing ..." will appear
on the display while the file is being deleted.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Executing..." display is showing.

The display shown in step 3, above, will reappear when the operation has finished.
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e Samplings Info

Displays the name of the sample files currently loaded in the TENORI-ON user memories.

1 Usethe jog dial and [OK] button to navigate to the Samplings function menu as follows:
"Main menu" — "File menu" — "Samplings"

Samel inas: =]
Operation:

2 Usethe jog dial to highlight the "Info" function, then press the [OK] button.

@- Oeven

Samel inas: =]
Operation:

3 Alistof the sample files currently loaded in the TENORI-ON user memories 1 — 3 will
be displayed.

© Inthisdisplay "1,""2," and "3" correspond to user memory numbers <1/16,> <02/16,> and <03/16.> If a
user memory is empty, "-------- " will be displayed.

4 Press the [OK] or [CANCEL] button to return to the display shown in step 2, above.
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M Effect Menu

The Effect menu provides access to functions that allow you to apply reverb and chorus
effects to the TENORI-ON voices.
The Effect menu submenu includes the following 4 items.

1. Reverb Type Page 99
2. Reverb Param Page 100
3. Chorus Type Page 100
4. Chorus Param Page 100

Use the jog dial to highlight a submenu item, then press the [OK] button to go to the
corresponding parameter edit display.

{[Effect mend ]

=]
args [ST=1"] . oK Q CANCEL

1. Reverb Type

Eewverb Torpe =]
{ }
Selects the reverb type.
e NO EFFECT ............. No reverb effect.
e HALL1T, HALL2 ... ... ... .. Concert hall reverb simulations.
¢ ROOM1, ROOM2, ROOM3 ... ... ... The type of reverb you'd hear in a room.
e STAGE1, STAGE2 .. .... .. Simulations of stage reverb.
e PLATE1, PLATE2. ... ...... Simulations of studio plate reverb units.
mRange............ NO EFFECT, HALL1, HALL2, ROOM1, ROOM2, ROOM3, STAGE1, STAGE2, PLATE1,
PLATE2

m Default ........... HALL1
mLED Buttons . ... ... No display
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2. Reverb Param

Eewverb  HA4LLA1 =]
FParam

Adjusts the depth of the reverb effect. Higher values produce greater reverb depth.

mRange............ 0—127
mDefault ........... 40

mLED Buttons . ... ... No display
3. Chorus Type

Chorus Tope =]

CHORLIS ]

Selects the chorus effect type.

eNOEFFECT..................... No chorus effect.

¢ CHORUS1,CHORUS2 . ........... Chorus effects.

e FLANGR1, FLANGR2 .. ........... Flanger effects.

mRange............ NO EFFECT, CHORUS1, CHORUS2, FLANGR1, FLANGR2
mDefault ........... NO EFFECT

mLEDButtons .. ... .. No display

4. Chorus Param

Chorus: =]
Param

Adjusts the depth of the chorus effect. Higher values produce greater chorus depth.

mRange............ 0—127
mDefault ........... 0
mLED Buttons . ... ... No display
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M Interior Menu

The Interior menu provides access to functions that allow you to set up the TENORI-ON to
function as a clock or automatically play back songs (Interior Mode) or to "sleep” if not
activated for a specified period of time (Power Save Mode).

The Interior menu submenu includes the following 10 items.

1. Interior START Page 101
2. Interior Type Page 102
3. Saver Type Page 102
4. Saver Time Page 103
5. Time Signal ON/OFF Page 103
6. Alarm ON/OFF Page 103
7. SetAlarm Page 104
8. Save As Time Signal Page 104
9.  Save As Alarm Page 105
10.  Clock Adjust Page 105

Use the jog dial to highlight a submenu item, then press the [OK] button to go to the
corresponding parameter edit display.

[Interior menul =]

aver [NT=1"] . oK O CANCEL

1. Interior Start

Interior START =]
START

Press the [OK] button while this display is showing to immediately begin operation of the
Interior Type specified in the next item.

© If you press the [OK] button to start the Interior Mode, The Saver Type is automatically set to "Interior."

mRange............ None
mLED Buttons . ... ... No display
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2. Interior Type

Interior Tape =]

SonatDEMO

Specifies the type of function that will begin operation when the Interior Mode is started.

e Song (DEMO) . .................. Plays the pre-programmed TENORI-ON demo song.

eSONG(SD) . ... Randomly plays Song Files from an SD Memory Card.

eClock. ... Displays the time on the TENORI-ON matrix.

e Clock + Song (DEMO) . ........... Displays the time on the TENORI-ON matrix while playing the pre-pro-
grammed TENORI-ON demo song.

e Clock + Song (SD) ............... Displays the time on the TENORI-ON matrix while randomly playing Song

Files from an SD Memory Card.

mRange............ Song (DEMO), Song (SD), Clock, Clock+Song (DEMO), Clock+Song (SD)
m Default ........... Song (DEMO)
m LED Buttons . ... ... No display
3. Saver Type
Saver Tape =]

Selects the type of operation that will begin if the TENORI-ON is not operated for a specified
period of time.

e InteriorMode. . ......... ... ... .. Clock or song playback as specified by the Interior Type item, above.
e Power Save Mode . . .............. Power Save Mode operation (sequence stop and LED buttons out).
mRange............ Interior, Power Save

mDefault ........... Interior

mLED Buttons . ... ... No display
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4. Saver Time

Saver Time =]
Bl min

Sets the amount of time that must elapse before saver operation begins.
If the TENORI-ON is not operated for the time specified here, the type of operation specified
by the Saver Type item will begin.

mRange............ OFF, 1 — 1440 (minutes)
m Default ......... .. 10 (minutes)
mLED Buttons . ... ... No display

5. Time Signal ON/OFF

Time Signal =]
OH |

Determines whether an hourly chime will be played during Interior Mode operation. When
ON, the chime will sound on the hour at 00 minutes and 00 seconds. The total chime
playback time is 8 seconds. Performance data created on the TENORI-ON can be used in
place of the standard hourly chime (— Page 104: Save As Time Signal).

mRange............ ON, OFF
mDefault ........... OFF
mLED Buttons . ... ... No display

6. Alarm ON/OFF

-

Determines whether the alarm will sound during Interior Mode operation. The total alarm
playback time is 48 seconds. Performance data created on the TENORI-ON can be used in
place of the standard alarm (— Page 105: Save As Alarm).

mRange............ ON, OFF
m Default ........... OFF
m LED Buttons . ... ... No display
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7. Set Alarm

Set Alarm =]
ER: za

Sets the time at which the alarm will sound during Interior Mode operation.

© If the hourly chime and alarm are set to the same time (the alarm minutes are set to "00"), only the alarm will

sound.
mRange............ 00:00 — 23:59
mDefault ........... 00:00
mLED Buttons . ... ... No display

8. Save As Time Signal

Saveds Time Sianal =

Saves the performance data (active notes and settings) in the current block for use as the
time signal that will play as the hourly chime during Interior Mode operation.

© If you use this function to change the time signal (hourly chime), the original default time signal will be erased.
To restore the original time signal use the Factory Reset function.

After selecting the block containing the data you want to save as the time signal, press the
[OK] button while this display is showing to save the data as the time signal.

© Press the [CANCEL] button (or use the jog dial to select "CANCEL" on the LCD and then press the [OK]
button) if you want to cancel the operation.

If you press the [OK] button to execute the operation, "Saving ..." will appear on the display
while the data is being saved.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while
the "Saving..." display is showing.

mRange............ OK, CANCEL
m Default ........... OK
mLED Buttons . ... ... No display
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9. Save As Alarm

Saveds Alarm =]
[ OK |

Saves the performance data (active notes and settings) in the current block for use as the
alarm that will play during Interior Mode operation.

© |If you use this function to change the alarm, the original default alarm will be erased. To restore the original
alarm use the Factory Reset function.

After selecting the block containing the data you want to save as the alarm, press the [OK]
button while this display is showing to save the data as the alarm.

© Press the [CANCEL] button (or use the jog dial to select "CANCEL" on the LCD and then press the [OK]
button) if you want to cancel the operation.

If you press the [OK] button to execute the operation, "Saving ..." will appear on the display
while the data is being saved.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while
the "Saving..." display is showing.

mRange............ OK, CANCEL
m Default ......... .. OK
mLED Buttons . ... ... No display
10. Clock Adjust
Clock Adig =]
Year: ZE
Laa i

Time:12:60:60

Sets the clock year, month, day, and time.

Press the [OK] button after setting each parameter to highlight the next parameter.
Pressing the [OK] button after the last parameter has been set applies the new clock
settings.

mRange............ Year: 2000 — 2099
Month & Day: 01 — 12/01 — 31
Time: 00 — 23/00 — 59
*Seconds cannot be adjusted.
m Default ........... OK

m LED Buttons . ... ... No display
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M System Menu

The System menu provides access to functions related to basic system operation, such as
factory reset, SD Memory Card formatting, and others.
The System menu submenu includes the following 5 items.

1. Save As Default Page 106
2. SD Format Page 107
3. Owner Name Page 107
4. Version Check Page 108
5. Factory Reset Page 108

Use the jog dial to highlight a submenu item, then press the [OK] button to go to the
corresponding parameter edit display.

[Su=tem menul =]

wher ame . oK Q CANCEL

1. Save As Default

Saveds Default =]
[ OK |

Saves the current settings for all blocks and layers as the power-on defaults that will be
automatically recalled when the TENORI-ON is turned on. If this function is not used to save
any user settings as defaults, the initial factory settings are used.

Press the [OK] button while this display is showing to save the current settings as the power-
on defaults.

When you press the [OK] button "Saving ..." will appear on the display while the data is
being saved.

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while
the "Saving..." display is showing.

©® Press the [CANCEL] button (or use the jog dial to select "CANCEL" on the LCD and then press the [OK]
button) if you want to cancel the operation.

mRange............ OK, CANCEL
mDefault ........... OK
mLED Buttons . ... ... No display
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2. SD Format

Before using SD Memory Cards with the TENORI-ON, be sure to read “Handling SD™ Memory Cards”
on Page 63.

S0 Format =]
[ OK |

Formats an SD Memory Card for use with the TENORI-ON.

© SD cards with a capacity greater than 32 MB will be formatted using FAT32 format, while SD cards with a
capacity of 32 MB or less will be formatted using FAT16 format.

After inserting an SD Memory Card into the card slot, press the [OK] button while this display
is showing to begin formatting.

When you press the [OK] button "Formatting ..." will appear on the display while the card is
being formatted.

A The format operation will erase all data from the SD Memory Card. Make sure there is not important
data you want to keep on a card before formatting it.

A Do not turn off the power or remove the SD Memory Card while the "Formatting..." display is showing.

© Press the [CANCEL] button (or use the jog dial to select "CANCEL" on the LCD and then press the [OK]
button) if you want to cancel the operation.

mRange............ OK, CANCEL
mDefault ........... OK
mLED Buttons . ... ... No display

3. Owner Name

Input Dwner Hame (=]
[HO HakER 1
ABCDEFGHI JELMHOPRRST
LMY 2—31 23d 26729 <4

This function lets you register an "Owner Name" in the TENORI-ON memory.
The Owner Name you register will be stored with song files as the "Composer Name", and
will be shown on the LCD along with the Song name when the file is played back.

1 The factory default owner name — "NO NAME" — will appear on the display. You can enter
a new owner name as required.
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The name entry procedure is described in the Rename Song section on Page 65.

® Owner names can be up to 16 characters in length.

. N
Owner Name Input Field ( I?ﬁHtHEI:'I l& Hame 1}3 Input Cursor
AECDEF GH [nJKLMHDPE!R(S_ﬁ
UMINEYE-B1 23436789 <t SetName
Available Characters ——————————— Backspace & Delete 1 Character

2 When the owner name has been entered as required use the jog dial to highlight the "¢"
symbol in the lower right corner of the display and press the [OK] button.

3 The submenu display will reappear when the name has been entered.

4. Version Check

Version Check =]
TEHORI-OH Mer .=, xx

Displays the version number of the TENORI-ON system ROM.

5. Factory Reset

Faztora Reset =]
[ OK |

Resets all TENORI-ON parameters to the original factory settings. All blocks and all layers
are restored to the factory default settings, and all active notes are cleared. All registered
data — alarm, time signal, owner name, etc. — will also be cleared, as will the Save As Default
(— Page 106) settings. Loaded sampling files will not be initialized.

Press the [OK] button while this display is showing to restore the factory defaults.

©® Press the [CANCEL] button (or use the jog dial to select "CANCEL" on the LCD and then press the [OK]
button) if you want to cancel the operation.

mRange............ OK, CANCEL
m Default ........... OK
m LED Buttons . ... ... No display
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M Recording Menu

This menu provides access to the TENORI-ON real-time recording function.

Before using SD Memory Cards with the TENORI-ON, be sure to read “Handling SD™ Memory Cards”
on Page 63.

1 InsertanSD Memory Card that has been properly formatted by the TENORI-ON into the
card slot.

2 Usethe jog dial select "Main Menu" — "Recording menu," then press the [OK] button to
the Recording menu START display.

[Recordinag menul (=

3 Pressthe [OK] button while the above display is showing to begin recording.

© Master volume (— Page 33) changes will be recorded during song recording, whereas hardware
volume (— Page 43) will not.

© Press the [CANCEL] button if you want to cancel recording.

Recording will begin from the instant you press the [OK] button, and all performance
data for all layers and blocks (note position data), LED button operations, function
button operations (voice, tempo settings, etc.), and [CLEAR] button operations will be
recorded in real time. The maximum amount of data that can be recorded is 39
kilobytes. This corresponds to approximately 1,000 button or dial operations.

The following display will appear during recording, showing the current layer status and
elapsed recording time.

Current Layer Number — Mode Name mE HNORI-OM = w

B1-Score [MEHA]-—— Current Block Number
Current Voice Number and Name EE#*E] /A1 Photon
| EEGE S 3 J

Elapsed Recording Time —————

® When you reach the point of 1,000 panel control events (button or dial operations), recording is
stopped automatically and no further events can be entered. A display appears prompting you to save
the recorded performance (containing the last 1,000 events) as a Song File to an SD Memory Card.
Press the [OK] button to begin the Song file save procedure.

4 Press the [OK] button to stop recording.
A display that will allow the recorded performance to be saved as a Song File to the SD
Memory Card will appear. Press the [OK] button to begin the Song file save procedure.

© Press the [CANCEL] button (or use the jog dial to select "CANCEL" on the LCD and then press the [OK]
button) if you want to cancel the recording.

Save this Sona¥ =]

. oK O CANCEL
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5 The Song File name entry display will appear. A default file name will be displayed,
which you can either use as-is or replace with a different name.
File name entry procedure is described in the Rename Song section on Page 65.

© File names can be up to 16 characters in length. The file extension will be added automatically.

5 ) (Input File Hames =
efault File Name AEAZE-SOMGE-E 1@}77 Input Cursor
AECDEF GH [nJKLMHDPE!R(S_ﬁ
UNMINEYE-B1 23436789+t ) SetFile Name
Available Characters ———————————— Backspace & Delete 1 Character

6 When the file name has been entered as required use the jog dial to highlight the "¢"
symbol in the lower right corner of the display and press the [OK] button.
The file name will be entered and the save function will be executed.
A display like the one shown below will appear while the Song file is being saved.
You can cancel the operation by pressing the [OK] or [CANCEL] button.

Sona: =] w
"BIAZE-SOMG-81 £ J The Song file being saved.

Sawvina. .. LCA&HCEL

File data may be irreparably corrupted if you turn off the power or remove the SD Memory Card while the
A "Saving..." display is showing.

o If afile with the same name exists on the SD Memory Card an overwrite confirmation display like the
one shown below will appear.

Sona: =]
SOHGET1BZE-81
A reada Exi 1
Overwrite?

©® Press the [OK] button if it's OK to overwrite the file. Press the [CANCEL] button (or use the jog dial to
select "CANCEL" on the LCD and then press the [OK] button) to cancel the operation and leave the
original file unaltered.

7 The display shown in step 2, above, will reappear when the operation has finished.
© Songs cannot be edited after they have been recorded. However, you can save the current layer or

block(s) by selecting and saving All Blocks, Current Block, or Current Layer from the File menu, and
then reload the data and edit it as required.
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Display Message List

‘ Display Message List

Fower Sawe. ..

Power Save mode in operation.

Mode different.
Can’t Copal

This message will appear if you attempt to use the CopythisLayer function (— page 56) to copy
between layers that have different performance modes. Data cannot be copied between layers

that have different mode.

This message will appear after you execute a copy, clear, or reset function from the Edit menu.

Press the [OK] button to undo the copy, clear, or reset function just executed.

UHDO?
Press the [CANCEL] button, or any button other than the [OK] button, or wait for the 15-second
timeout to return to the menu.

Loading. . Currently loading a file. . o . .
Don't turn off the power or remove the SD Memory Card while this display is showing.

Saving Currently saving a file to an SD Memory Card or the internal flash memory.

o Don'’t turn off the power or remove the SD Memory Card while this display is showing.
Executing. . Currently executing a file rename or delete operation.

Don't turn off the power or remove the SD Memory Card while this display is showing.

Formattina. ..

Currently formatting an SD Memory Card.

S0 Card Error!
Mo S0 Card.

No SD Memory Card is in the card slot.

Unformatted!

The SD Memory Card in the card slot has not been formatted.

S0 Card Error!
Card is Locked.

The SD Memory Card write-protect switch is "ON" (write protected).

Sl Card Error!
Access Timeout.

A timeout error has occurred during a SD Memory Card save or load operation.

S0 Card Error!
Illesal Media.

The media in the card slot is unsupported.

S0 Card Error!
Card i=s Full.

The SD Memory Card is full and no more data can be written to it.

S0 Card Error!
Card is Mot Reads.

The SD Memory Card is not ready for a read or write operation.

S0 Card Error!
Illesal File Hame.

The name specified for ma file load operation is not allowed.

S0 Card Error!
Illesal Format.

The format of the card in the card slot is not supported.

Sl Card Error!

Mot Supported File.

The file format is not supported.

S0 Card Error!

The File is Broken.

The file is corrupted.

S0 Card Error!
Can not Oren File.

The file cannot be opened.

S0 Card Error!

Can not Write File.

The file cannot be written.

S0 Card Error!
Can not Read File.

The file cannot be read.

S0 Card Error!
Urexpected Ervaor.

An unexpected error has occurred.

Sl Card Error!
Mode is Different.

The performance mode and TENORI-ON mode are different.

Alarm Plaging. ..

The alarm is currently playing in the Interior Mode.

Time Sianal. ..

The time signal is currently playing in the Interior Mode.
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Display Message List

Clear Lawer
EBlockl##] Lagerl ]

All active notes have been cleared from the current layer/block.

Clear all

All active notes have been cleared from all layers and blocks.

Sona
Alreads Existsl
Oyerwrite?

This display will appear when a song file with the same name already exists.
Press the [OK] button if it's OK to overwrite the file.
Press the [CANCEL] button to cancel the overwrite operation.

Elocks
Already Existsl
Oyerwrite?

This display will appear when an all block file with the same name already exists.
Press the [OK] button if it's OK to overwrite the file.
Press the [CANCEL] button to cancel the overwrite operation.

Bl ook ]
Al reads Existsl
Oyerwrite?

This display will appear when a block file with the same name already exists.
Press the [OK] button if it's OK to overwrite the file.
Press the [CANCEL] button to cancel the overwrite operation.

Lasgerl++]
Al reads Existsl
Oyerwrite?

This display will appear when a layer file with the same name already exists.
Press the [OK] button if it's OK to overwrite the file.
Press the [CANCEL] button to cancel the overwrite operation.

Settinas
Al ready Existsl
Owerwri ey

This display will appear when a setting file with the same name already exists.
Press the [OK] button if it's OK to overwrite the file.
Press the [CANCEL] button to cancel the overwrite operation.

Same | inas
Alreads Exists!
Owerwrite?

This display will appear when a sampling file with the same name already exists.
Press the [OK] button if it's OK to overwrite the file.
Press the [CANCEL] button to cancel the overwrite operation.
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Troubleshooting

Symptom

Possible Cause & Solution

Page

Overall

Clicks and pops occur occasionally.

Noise can be produced by nearby electronic devices being turned on
or off, electrical motors, or similar sources. Try to use an electrical
output as far away from the suspected noise source as possible. If no
cause can be found, contact your Yamaha service center.

Interference from mobile phones, radios,
television sets, and similar devices.

Interference can be caused by mobile phones, radio transmitters, or
similar devices operating in the vicinity of the instrument. If the noise
seems to be excessive contact your Yamaha service center.

The instrument causes interference with
radios or television sets.

This instrument can cause interference if operated too close to radio
or television receivers. Move the instrument further away from the
receiving devices if interference occurs.

The long-press (sensitivity) parameter may be set to too long a time.

No response to long button presses. age 60
P 9 P Reduce the time setting. pag
No Sound
Local Control may be off. If off it should be turned on. page 61
The volume may be turned all the way down. Turn it up to an page 33,
appropriate level. 43
A pair of headphones or external speakers may be connected. -
No Sound P P P v
The mute function may be engaged. Turn it off. page 47
MIDI connection is not established with the Master TENORI-ON, or
does not operate properly, even though "Slave Mode" is selected in -
the "Preference menu".
The instrument’s 32-note maximum polyphony has been exceeded
(i.e. more than 32 notes are being played at once).
In all modes other than the Push Mode, only one note of a given pitch
can play at the same time in a single layer. When a second note of the
same pitch is played in the same layer, any previous note of the same
Some notes cut off. pitch is turned off before the new note is played.
The Sound Length setting is too long. The TENORI-ON uses a stereo
tone generator (each note uses two notes of the instrument’s
polyphony), so when a long Sound Length is specified the maximum -
polyphony (number of simultaneous notes) can be easily exceeded,
with the result that the notes may not play as expected.
Pitch and Voices
The scale assigned to the vertical/ A scale other than the default lonian scale has been selected. Select ace 44
horizontal axis does not sound right. the lonian scale. pag
When a new block is selected and the
voice is changed, the voice used in the The same voice applies to the same-numbered layers in all blocks. page 6
first layer changes as well.
Data Storage and Initialization
Settings are not retained at the next ) ) . .
ng : % Save settings you want retained using the Save As Default function. page 106
power-on.
Some parameters are not initialized when Some parameters saved using the Save As Default function are not page 39

the Reset All Blocks function is executed.

initialized.
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Troubleshooting

Symptom

Possible Cause & Solution

Page

SD Memory Card

Can't record or play.

The SD Memory Card is write-protected. Set the card’s write-protect
switch to the OFF position.

page 63

Too much performance data. Performances that exceed 39KB (About
1000 operations) cannot be recorded.

Not enough remaining SD Memory Card capacity. Use a different SD
Memory Card.

Cannot perform file operations.

Save and rename operations can only be performed on up to 100 files
that have file names in which the first five characters are the same.

The SD Memory Card is write-protected. Set the card’s write-protect
switch to the OFF position.

page 63

Not enough remaining SD Memory Card capacity. Use a different SD
Memory Card.

The maximum number of files has been exceeded. Up to 1,000 files
can be stored in the TENORI-ON folder, or up to 256 files of each file-
extension type.

page 62

A loaded All Blocks, Current Block, or
Current Layer file does not play
automatically.

If playback is paused when a file is loaded, the loaded file will not be
played automatically. Return to the status display and press the [OK]
button to begin playback.

Others

The loop indicator doesn’t move.

The pause mode may have been engaged by pressing the [OK]
button. Press the [OK] button a second time.

The loop point and/or loop speed settings
have changed.

These settings change when the Play menu Master Loop Point and
Master Loop Speed settings are changed.
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MIDI Data Format

TENORI-ON MIDI Transmit/Receive Event Specifications

1. Transmittable/Receivable System Messages

The TENORI-ON transmits MIDI messages corresponding to operations performed on it, and
received MIDI messages can be used to control the TENORI-ON tone generator. System
messages that can be transmitted and received by the TENORI-ON are listed below. Refer to
the MIDI Implementation Chart for other message types.

System Messages that Can Be Transmitted and Received By the TENORI-ON

Type Details Transmit Receive

Timing Clock (F8) o o2
Start (FA) o1 o2

System Realtime Continue (FB) X o2
Stop (FC) o1 o2
Active Sensing (FE) o [Ox¢]
Master Volume (FO 7F 7F 04 01 00 dd F7) ] [Ox¢]
Master Volume (FO 43 10 4C 00 00 04 dd F7) X o3
Master Tune (FO 43 10 27 30 00 00 dd dd 00 F7) O o3

System Exclusive Master Tune (FO 43 10 4C 00 00 00 dd dd dd dd F7) X o3
Reverb Type (FO 43 10 4C 02 01 00 dd dd F7) O o3
Chorus TYpe (FO 43 10 4C 02 01 20 dd dd F7) o 03
TENORI-ON Exclusive (FO 43 73 01 33 00 dd dd dd F7) @) X

*1 Transmitted only in Master Mode. *2 Received only in Slave Mode. *3 Received only in Master Mode.

System Realtime Messages FE and F8 are continuously transmitted (in the Master Mode) after startup regardless of sequencer start/
stop operations.

2. TENORI-ON Specific System Exclusive Messages

MIDI messages corresponding to button or dial operations performed on the TENORI-ON
are output as System Exclusive Messages. The format used for these messages is listed
below.

11110000 FO Exclusive Status
01000011 43 YAMAHA ID
01110011 73 Device ID
00000001 o1 Model ID
00110011 33 Sub ID 1
00000000 00 SubID2
Oddddddd dd Data1l
0ddddddd dd Data2
0ddddddd dd Data3

11110111 F7 End of Exclusive
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Data1
B7 B6 B5 B4 B3 B2 B1 BO
0 0 0 TYPE1 TYPEO 0 STATAH STATO
TYPE [1:0]
Controller Types
TYPE1 TYPEO Controller
0 0 Frame Button
0 1 Panel Button
1 0 Dial
STAT [1:0]
Controller Status
STAT1 STATO Status
0 0 Button OFF or Dial Down
0 1 Button ON or Dial Up
1 1 Dial Stop
Data2
B7 B6 B5 B4 B3 B2 B1 BO
0 0 0 X4 X3 X2 X1 X0
X [4:0]

When TYPE [1:0] is 00 (Frame Button):
Frame Button Types

X4 X3 X2 X1 X0 Button
0 0 0 0 0 Cansel
0 0 0 0 1 OK
0 0 0 1 0 Clear
0 1 0 0 0 R1
0 1 0 0 1 R2
0 1 0 1 0 R3
0 1 0 1 1 R4
0 1 1 0 0 R5
1 0 0 0 0 L1
1 0 0 0 1 L2
1 0 0 1 0 L3
1 0 0 1 1 L4
1 0 1 0 0 L5

When TYPE [1:0] is 01 (Panel Button):
Panel Button Horizontal Axis (0, 1, 2, ... 15, from left to right).

X4 X3 | X2 | X1 | X0
0 Panel Button Horizontal Axis (0-15)

When TYPE [1:0] is 10 (Dial):
Dial Control Range (0-15).

X4 X3 | X2 | X1 | X0
0 Dial Control Range (0-15)
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Data3
B7 B6 B5 B4 B3 B2 B1 BO
0 0 0 0 Y3 Y2 Y1 YO
Y [3:0]

When TYPE [1:0] is 01 (Panel Button):
Panel Button Vertical Axis (0, 1, 2, ... 15, from top to bottom).

Y3 | Y2 | Y1 | Yo
Panel Button Vertical Axis (0-15)

When TYPE [1:0] is 00 (Frame Button) or 10 (Dial):

All 0.
Y3 Y2 1 Yo
0 0 0 0
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YAMAHA [ TENORI-ON ]

Model TNR-W/TNR-O MIDI Implementation Chart

Date :13-Feb-2007
Version : 1.0

Function... Transmitted Recognized Remarks
Basic Default 1 - 16 1 - 16
Channel Changed X X
Mode Default 3 3
Messages | X X
Altered *kkkkhkkhkhkk ik khkhk k% X
Note 0 - 127 0 - 127
Number True volce | *F***kxxdxdixss 0 - 127
Velocity Note ON | O 9nH,v=100 O 9nH,v=1-127
Note OFF| X X
After Key's X X
Touch Ch's X X
Pitch Bend X X
Control 0,32 | O O Bank Select
Change 710 O Main Volume
10 | O O Panpot
11| O O Expression
91,93 | O O Effect Depth
Prog o0 - 127 o0 - 127
Change True # *kkkkhkkhkhkkhkhk khkk*k
System Exclusive O O
Common song Pos.| X X
Song Sel.| X X
Tune X X
System Clock O ot
Real Time Commands | O ot
All Sound Off | X X (120,126,127)
Aux Reset All Cntrls| X X (121)
Local ON/OFF | X X
Mes- : All Notes OFF | X X (123-125)
sages: Active Sense | O O
: Reset X X
Note :"* Only effective in Slave Mode.
Mode 1 OMNI ON , POLY Mode 2 OMNI ON ,MONO O Yes
Mode 3 OMNI OFF, POLY Mode 4 OMNI OFF,MONO X No
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Voice List

Voice List

When you specify a program change as a number in the range of 0 — 127, specify a number
that is one less than the program number listed below.

Voice # Displayed Voice
Category | MSB | LSB | Prog (’\‘l/::i:::/ Voice Name
# # # Horizontal)

Layer 1 63 1 1 01/01 Photon
63 1 2 01/02 Photopia
63 1 3 01/03 Pearl
63 1 4 01/04 Pulse
63 1 5 01/05 Cell
63 1 6 01/06 Pixel
63 1 7 01/07 Serene
63 1 8 01/08 Electron
63 1 9 01/09 Winter
63 1 10 01/10 SoftMmb
63 1 ihl ot1/11 SoftAcco
63 1 12 01/12 SoftHarm
63 1 13 01/13 GrandPno
63 1 14 01/14 QuietPno
63 1 15 01/15 OldPiano
63 0 1 01/16 User1

Layer 2 63 1 16 02/01 eKalimba
63 1 17 02/02 LiteOrg
63 1 18 02/03 GlassTap
63 1 19 02/04 Drop
63 1 20 02/05 Shimmery
63 1 21 02/06 Mist
63 1 22 02/07 Acorn
63 1 23 02/08 Chime
63 1 24 02/09 ThumbPno
63 1 25 02/10 ToyTrain
63 1 26 02/11 ToyBanjo
63 1 27 02/12 LazyBass
63 1 28 02/13 Crocus
63 1 29 02/14 CandyCan
63 1 30 02/15 Peaceful
63 0 2 02/16 User2

Layer 3 63 1 31 03/01 OrgFlute
63 1 32 03/02 GtrHarmo
63 1 33 03/03 GreenFlt
63 1 34 03/04 Lonely
63 1 35 03/05 Murmur
63 1 36 03/06 OrganLT
63 1 37 03/07 TinyWind
63 1 38 03/08 Bassoon
63 1 39 03/09 Hopper
63 1 40 03/10 PopEcho
63 1 41 03/11 PopStr
63 1 42 03/12 Maple
63 1 43 03/13 ToyRobot
63 1 44 03/14 Tropical
63 1 45 03/15 Floating
63 0 3 03/16 User3

Voice # Displayed Voice
Category | MSB | LSB | Prog Num.ber Voice Name
(Vertical/
# # # Horizontal)

Layer 4 63 1 46 04/01 NMCanon
63 1 47 04/02 LeedPlus
63 1 48 04/03 DotGame
63 1 49 04/04 HardBeep
63 1 50 04/05 PopFlang
63 1 51 04/06 PeekTone
63 1 52 04/07 RetroPop
63 1 53 04/08 SonarPad
63 1 54 04/09 CaveDrop
63 1 55 04/10 DullBeep
63 1 56 04/11 SnapStr
63 1 57 04/12 MellowB
63 1 58 04/13 BasicB
63 1 59 04/14 PowerB
63 1 60 04/15 MetalB
63 1 61 04/16 SlowB

Layer 5 63 1 62 05/01 EchoBass
63 1 63 05/02 PizzStr
63 1 64 05/03 SinePop
63 1 65 05/04 PowerPop
63 1 66 05/05 Blip
63 1 67 05/06 WindPass
63 1 68 05/07 DonPiyo
63 1 69 05/08 MetalHit
63 1 70 05/09 BuzzPop
63 1 71 05/10 FlowOut
63 1 72 05/11 Spring
63 1 73 05/12 BublEcho
63 1 74 05/13 Pico
63 1 75 05/14 LightPop
63 1 76 05/15 RainDrop
63 1 77 05/16 Creak

Layer 6 63 1 78 06/01 TreeFrog
63 1 79 06/02 Squeeze
63 1 80 06/03 FootStep
63 1 81 06/04 Carib
63 1 82 06/05 Point
63 1 83 06/06 EchoTom
63 1 84 06/07 PureTom
63 1 85 06/08 TinBox
63 1 86 06/09 Boom
63 1 87 06/10 LowBoom
63 1 88 06/11 EchoBoom
63 1 89 06/12 SoftBoom
63 1 90 06/13 LargeBox
63 1 91 06/14 Barrel
63 1 92 06/15 AirSynth
63 1 93 06/16 SteelDrm
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Voice # Displayed Voice Voice # Displayed Voice
Category | MSB | LSB | Prog ('\\ll::‘ti:::‘l Voice Name Category | MSB | LSB | Prog ('\“l::‘i:’::/ Voice Name
# # # Horizontal) # # # Horizontal)

Layer 7 63 1 94 07/01 HighKit Layer 10 63 2 17 10/01 Marble
63 1 95 07/02 BumpKit 63 2 18 10/02 PinBall
63 1 96 07/03 StompKit 63 2 19 10/03 TinToy
63 1 97 07/04 BangKit 63 2 20 10/04 Chick
63 1 98 07/05 ScrubKit 63 2 21 10/05 Vibes
63 1 99 07/06 HandKit 63 2 22 10/06 SineMmb
63 1 100 07/07 MouthKit 63 2 23 10/07 Harp
63 1 101 07/08 EastKit 63 2 24 10/08 Opinion
63 1 102 07/09 EastKit2 63 2 25 10/09 Stuffy
63 1 103 07/10 EchoKit 63 2 26 10/10 Sulky
63 1 104 07/11 PowerKit 63 2 27 10/11 Log
63 1 105 07/12 SnapKit 63 2 28 10/12 Oscillat
63 1 106 07/13 LowKit 63 2 29 10/13 Grief
63 1 107 07/14 MidKit 63 2 30 10/14 Bubble
63 1 108 07/15 Knocks 63 2 31 10/15 Plankton
63 1 109 07/16 Stomp 63 2 32 10/16 Popcorn

Layer 8 63 1 110 08/01 Square Layer 11 63 2 33 11/01 Acordion
63 1 111 08/02 Aroma 63 2 34 11/02 Viola
63 1 112 08/03 Sprout 63 2 35 11/03 Cello
63 1 113 08/04 Spot 63 2 36 11/04 Violin
63 1 114 08/05 Quasar 63 2 37 11/05 Contrabs
63 1 115 08/06 BeanBag 63 2 38 11/06 SfotStr
63 1 116 08/07 TipToe 63 2 39 11/07 Strings
63 1 117 08/08 Gemini 63 2 40 11/08 Piccolo
63 1 118 08/09 Apollo 63 2 41 11/09 Flute
63 1 119 08/10 Hexagon 63 2 42 1110 Recorder
63 1 120 08/11 Green 63 2 43 11/11 PanFlute
63 1 121 08/12 DoLoop 63 2 44 1112 Bagpipe
63 1 122 08/13 Milli 63 2 45 1113 Clarinet
63 1 123 08/14 Centi 63 2 46 11/14 Oboe
63 1 124 08/15 Deca 63 2 47 1115 Harmnica
63 1 125 08/16 Hect 63 2 48 11/16 El.Grand

Layer 9 63 2 1 09/01 Peanuts Layer 12 63 2 49 12/01 LadyBird
63 2 2 09/02 Walnut 63 2 50 12/02 Tsugumi
63 2 3 09/03 Ping 63 2 51 12/03 WhiteEye
63 2 4 09/04 Pong 63 2 52 12/04 NewHope
63 2 5 09/05 Mallet 63 2 53 12/05 Trickle
63 2 6 09/06 HumOrgan 63 2 54 12/06 MayFly
63 2 7 09/07 BuzOrgan 63 2 55 12/07 Moth
63 2 8 09/08 PopOrgan 63 2 56 12/08 GlasPerc
63 2 9 09/09 JazOrgan 63 2 57 12/09 SinelLead
63 2 10 09/10 ResOrgan 63 2 58 12/10 Flick
63 2 11 09/11 FuzOrgan 63 2 59 12/11 Doze
63 2 12 09/12 PufOrgan 63 2 60 12/12 Sleep
63 2 13 09/13 PicOrgan 63 2 61 12/13 ElecToy
63 2 14 09/14 DropEcho 63 2 62 12/14 Frog
63 2 15 09/15 Sesame 63 2 63 12/15 RadioPno
63 2 16 09/16 Delta 63 2 64 12/16 Droid
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Voice # Displayed Voice Voice # Displayed Voice
Category | MSB | LSB | Prog ('\\JI::‘ti:::I Voice Name Category | MSB | LSB | Prog ('\“l::‘i?:::/ Voice Name
# # # Horizontal) # # # Horizontal)

Layer 13 63 2 65 13/01 Children Layer 16 63 2 113 16/01 SlowFlux
63 2 66 13/02 Aqua 63 2 114 16/02 AirFlow
63 2 67 13/03 Pierrot 63 2 115 16/03 Dynamo
63 2 68 13/04 Musicbox 63 2 116 16/04 Field
63 2 69 13/05 Fairy 63 2 17 16/05 Closed
63 2 70 13/06 Ukulet 63 2 118 16/06 Parallel
63 2 71 13/07 Molecule 63 2 119 16/07 Proton
63 2 72 13/08 Sparkler 63 2 120 16/08 Radiator
63 2 73 13/09 AirTweet 63 2 121 16/09 Neutron
63 2 74 13/10 Neutrino 63 2 122 16/10 Particle
63 2 75 13/11 CosmoRay 63 2 123 16/11 Aerial
63 2 76 13/12 EIf 63 2 124 16/12 lon
63 2 77 13/13 Elfin 63 2 125 16/13 Glow
63 2 78 13/14 ChitChat 63 2 126 16/14 Spiral
63 2 79 13/15 RayDrop 63 2 127 16/15 Oxygen
63 2 80 13/16 Ozone 63 2 128 16/16 Velocity

Layer 14 63 2 81 14/01 Chrome
63 2 82 14/02 Oak
63 2 83 14/03 Awake
63 2 84 14/04 Ebony
63 2 85 14/05 Epoxy
63 2 86 14/06 Pendulum
63 2 87 14/07 Xylophon
63 2 88 14/08 Marimba
63 2 89 14/09 MetalXY
63 2 90 14/10 SoftFoot
63 2 91 14/11 PopUP
63 2 92 14/12 Helium
63 2 93 14/13 Locust
63 2 94 14/14 TinyBell
63 2 95 14/15 PopVibes
63 2 96 14/16 Balimba

Layer 15 63 2 97 15/01 Candera
63 2 98 15/02 Orbit
63 2 99 15/03 Helix
63 2 100 15/04 Fade
63 2 101 15/05 Appear
63 2 102 15/06 SlowRay
63 2 103 15/07 PhaseOrg
63 2 104 15/08 Sunspot
63 2 105 15/09 Whistle
63 2 106 15/10 Corona
63 2 107 15/11 Diode
63 2 108 15/12 Zone
63 2 109 15/13 Venus
63 2 110 15/14 Mercury
63 2 111 15/15 Polar
63 2 112 15/16 Pai
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Index
A J Random Mode ........... 17,28
RecordingMenu ........... 109
Active Notes . .............. 16 JogDial ................... 36 "9 .
Reset AllBlocks .. ........... 58
Alarm ON/OFF ............ 1083 Reset Loob Timin 46
AllBlock Set ............... 39 - PHIMING - ovvvvern
Reverb Param ............. 100
AllBlocks .. ...t 68 L 24
. Reverb Type ............... 99
All Settings . ............... 83 [L2] oo 25 )
L Rotation ................... 28
Animation ................. 53 [L3] v 26
[L4] oo 27,28 S
B [LE] e 29 )
Samplings . ................ 88
Backup ........... ... ... 39 Layer .......... .. .. ... 4,5,30 Save 39
BlocK ..o 5,34 LayerMenu ................ 4g T oot
Save AllBlocks . ............ 69
Bounce Mode .............. 19 Layer Volume .............. 33
Save AsAlarm ............. 105
Local Control . .............. 61
C ) Save As Default . ........... 106
Loop Indicator ........... 15, 61 Save As Time Sianal 104
CANCEL ............... 38,54  Loop Point .............. 27, 46 , gnal -« .e-
SaverTime ............... 1083
Chorus Param ............. 100 Loop Speed (Layer) ....... 29, 51 Saver Tvoe 102
Chorus Type .............. 100 Loop Speed (Master) .. ....... 45 YPE e
CLEAR 13 ScoreMode ............. 15,27
"""""""""" SD Memory Card ..........9,63
Clear All Blocks . ............ 57 M y
) ) SetAlarm ................. 104
ClearthisBlock ............. 55 Master Loop Point . .......... 46 Solo Mode o1
Clear this Layer . ............ 57 Master Loop Speed ... ....... 45 Sora .. 64
Clock Adjust . ............. 105 Master Scale ............... 44 9 e
) Song (Playback) ............ 65
Connecting ................. 7 Master Tempo .. ......... 31,43 )
) Song (Recording) .......... 109
Copy thisBlock ............. 55 Master Transpose ........ 32,45 Sound Lenath o5 52
Copy this Layer ............. 56 Master Tuning .............. 60 ) O e ’
Status Display .............. 12
CurrentBlock .............. 73 Master Volume ............. 33
Stop Playback .............. 14
Current Layer .............. 78 MIDI ... 7,115,118
Storage ... 39
Mute ... ... ... .. 47 )
D Synchronize ................ 61
SystemMenu.............. 106
DemoSong ............... 102 O y .
Display . .................. 12 Octave . .......ocovi... 26 T
DrawMode ................ 18 OK .o 37
W Time Signal ON/OFF ... ... .. 103
OwnerName .............. 107
E
P U
EditMenu ................. 54
Undo ............oiiia.. 54
EffectMenu ................ 99 Panpot ......... ... ... ... 53 .
User Voice .............. 24, 89
Parameter ........ 22, 39, 40, 41
F Performance Mode ........ 4,12 VvV
Factory Reset ............. 108 PlayMenu ................. 42
) y y Menu Version Check ............. 108
FileMenu ................. 62 PowerSave ............ 10, 102 Voice 6.119
Format (SD Mamory Card) ...107 PreferenceMenu ............ 59 T oo ’
. Volume (Hardware) .......... 43
Function Buttons ... ......... 23 PushMode ................ 20
o Volume (Layer) ............. 50
Push Sensitivity ............. 60
H Volume (Layer/Master) ....... 33
Hardware Volume ........... 43 Q
| Quantize .................. 60
Initialization .. .............. 39 R
Instrument . ............. 24,49 [R1] o 30
InteriorMenu . ............. 101 [R2] .o 31
Interior Start . ............. 101 [R3] oo 32
Interior Type . ............. 102 [R4] .. 33
[R5] oo 34
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